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Learning to Use the Studio Organizer

As a teacher, you know the value of proper instruction. Every day you share your knowledge and skills and pass them on to a new
generation. When it comes to computers, the younger generation has a distinct advantage; they have been taught how to use computers.
They also have hands on experience performing every day tasks. You know the value of expert instruction and experience. You make a
living by providing both.

For some reason, when it comes to computers we disregard instruction and experience. Maybe it's because computers are sold like
television sets. Despite what people in computer sales will lead you to believe, a computer is not a television set. Learning to use a
computer has a lot in common with learning to drive. How did you learn to drive? Someone taught you. The rules of the road were
spelled out for you. At first you drove around in empty lots. After a while they let you drive on public streets with an instructor beside
you. Finally, before you could drive by yourself, you had to take a test to prove you had the knowledge and experience to safely operate
a motor vehicle.

What if you didn't know the rules of the road and just started driving around town? I'll bet you could do it, but you sure would be
dangerous at intersections. How far would you get if all you could do was guess?

Using a computer to manage a business is very similar. You're headed for trouble fast if you have little to no instruction and no
experience. If you don't know the rules of the road for computers, you won't know where files are saved, you'll double click when you
should single click, and downloading software will be confusing. Even receiving technical support will be difficult. I know, I work with
end users every day, and my goal is to empower you.

It's essential to understand you have to receive instruction in order to use a computer. You have be taught the rules of the road. Then
you'll need some hands on time with someone beside you to apply the brakes if you take a wrong turn. How do you think the younger
generation knows so much about computers? They're taught in school. When they have a question, they raise their hand and a teacher
comes to their side, looks at their computer screen, and shows them how to perform the correct steps. That's instruction and experience.

There's more to owning and using a computer than receiving instruction. Computers need regular maintenance. That means operating
system updates, virus protection, security updates, backup software and more. Who is going to help you do all of this? Your computer
mentor. Finding one is as important as finding a good auto mechanic. Try to go it alone, and you’ll end up stranded on the side of the
road. Computers will frustrate and intimate you. If that describes your experience using a computer, you need a mentor. Don’t go it
alone. Get someone to be your guide. Start by asking your students.
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The first step is to read the free eBook This is Your Brain. As a teacher, you'll want to read this article. You'll learn how we learn and how fear blocks
learning. It also tells you how to find a computer mentor. This is Your Brain is already on your computer. It's inside the Free eBooks folder inside the
Studio Organizer folder on your hard drive. While you're there, please also print and read Lessons from the Road which helps you understand why
students sign up, why they quit and what you're really selling. It has an entire chapter devoted to computers.

Before you attempt to use the Studio Organizer (or any computer software) to manage your business, here's a brief check list of essential computer
skills:

__ I can define: upload, download and install. I can download software to my computer and know the location of downloaded files.
__ I'm comfortable running installation software. I know where software is being installed on my computer.
__ I understand the filing system of my computer. I know how to properly use Open and Save dialog boxes.
__ I can reorganize my files & folders and search my hard drive.
__ I know how to copy files & folders to a USB flash drive.
__ I known how to create shortcuts and aliases.
__ I know how to compress a file.
__ I know how to attach a file to an email.
__ I backup all of my unique files on a daily basis. I know how to restore a backup.
__ I install operating system and software updates as they become available. I keep my software current.
__ I perform regular maintenance to assure my computer is healthy and virus free.
__ If networking, I know how to open a shared network folder or volume.
__ I have a computer expert that can come to my computer and provide hands on training and troubleshooting.

The last one is the most important. Every computer user needs to have an expert to help them. (I have two.) Once you have the above basic skills
under your belt it's time to begin to use the Studio Organizer. Read each of the tutorials. Don't try to read them all in one sitting. Instead, pick a
chapter, sit down at the computer and teach yourself something new. Invest thirty minutes at a time and in a few weeks you'll understand how the
Studio Organizer was designed to be used.

The 10 Minute Rule: Frustration is Bad
If you find yourself stuck trying to do something, please stop after 10 minutes. Why? The longer you spend going nowhere, the more frustrated you'll
become. Please don't continue to repeat the same steps if something isn't working. Instead click the Support button and email me your questions. I've
made email Technical Support free and unlimited so you can always get an answer without having to worry about busy signals, missed phone calls,
hours of operation, or expensive support contracts.

Sincerely,
Jeff Pagano
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Welcome!

The Studio Organizer is the fifth major revision of the Martial Arts Organizer line of software products.
Since 1996 Martial Arts Organizer has been sold to over 1400 schools around the globe.

The Studio Organizer is a tremendous step forward, and significant changes have been made to accommodate dance,
gymnastics and yoga studios. Welcome! Suggestions are always encouraged, especially if the Studio Organizer is missing an
important feature commonly used in your industry. Feel free to email your suggestions and comments.

As you review the software and read the tutorials, you'll see our roots showing. We'll use martial arts terms like ranks,
promotions and training days. Feel free to disregard any terminology or features that don't apply to your industry.

Since all of the documentation was originally written for Martial Arts Organizer, we'll use the word student, but you can
select Customer, Client or Member on the General folder tab of the Preferences screen. You'll also the word rank, but you
can select level if that's more appropriate. The selections you make will appear in buttons, printouts, reports, ID cards and
more but you may see the words students or ranks in some dialog boxes or report descriptions.

This tutorial is designed to walk you through the process of entering your school's unique information into the Studio
Organizer. Most of what you'll do here is only done once, then it's done. It's not necessary to complete this entire tutorial at
one sitting.

Be sure to enter your school information, sales tax rates, styles of instruction and ranks right away. This information is
essential. You won't be able to properly create student records without entering the basic information first.

You may want to enter all of your complete class schedule, or enter all of your inventory items later.

Also, the information on these pages is taken from the built in Help. This was done so if you ever need a quick reminder, you
can just click the Help button on any screen and read the same text found in these tutorials.
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Install Only One Copy of the Studio Organizer

This is Very Important. Please Read this Page!
It's very important to be sure you have only one functional copy of the Studio Organizer installed on your computer. Since
the 30 day trial and the full working version are the exact same files, there is nothing more to download or install when you
purchase. Simply enter your Registration Code to disable the 30 day trial limitations.

Please be sure you have not installed more than one copy of the Studio Organizer on your computer. Also, please do not
copy the Studio Organizer folder to another location on your hard drive as a backup. If you do either of these you will have
more than one functional copy of the Studio Organizer installed on your computer. This can create tremendous problems,
especially if you are unaware you are using two different copies of the software.

Sometimes users will download and install several copies of the free 30 day trial. They'll purchase, register, and begin to
enter their data into one copy, then a few weeks or months later open a duplicate copy of the software that only contains the
sample data. They'll see the software has not been registered and think all their data has been lost when it fact it's in a
different set of files.

Another problem might be a user enters ten new student records into one copy of the Studio Organizer. The next day they
inadvertently open a different copy of the Studio Organizer. Those ten records will be not be there. Users that have duplicate
copies of the Studio Organizer will email tech support and say their data has disappeared. Unfortunately there is no way to
merge or synchronize records from two different sets of files to correct this error.

As you can see, it's very important to be sure there is only one copy of the Studio Organizer on your computer. Search your
computers hard drive for "Studio Organizer"  and files with a ".tso" extension. If you find more than one Studio Organizer
folder open the Data folder and examine the modification dates of the .tso files to determine which files have been modified
most recently. Delete the Studio Organizer folder that contains the older .tso files. Also be sure to delete any aliases or
shortcuts to the deleted files. Sorry, there is no way to merge or sync data from the old files.

Finally, if you're receiving an error message stating your free 30 day trial has expired, but you know you've already
registered your software, this also means you have two copies of the Studio Organizer installed on your computer. One has
been registered, and the second has been used for entering your student information. In this case, open the version which has
all of your current information and click the Purchase button and follow the steps to register the software. Then find and
delete the other, unused the Studio Organizer folder.
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Limitations & Warnings      Please Read!

Date Changing Prohibited
Please do not change the date on your computer to a previous date. Doing so will cause the Studio Organizer files to detect an error and lock. They
can only be reset by submitting the files to technical support. Instructions for submitting your file will be displayed on your screen.

Attendance Check In & Networking
It's not possible to record attendance while performing other computer tasks. The Studio Organizer must always be in attendance check in mode and
be the foreground application in order to record attendance. As a workaround to this limitation, a wizard has been designed that let's you dedicate a
computer to attendance recording. This is a free feature.
Or the Studio Organizer can be networked, with one computer dedicated to real time attendance recording.  The downside is one copy FileMaker Pro
software must be purchased for each computer you wish to network. The software costs about $300 per computer. The free solution, and networking
are explained in detail in the Working With Data tutorial.

Duplicate Installations
It's possible to install more than one copy of the Studio Organizer on your computer then have two sets of data files which cannot be merged. This is a
computer housekeeping issue which is easily avoided. Please read Only One Copy Of The Studio Organizer.

Updates & Student Photos
From time to time the Studio Organizer is updated to add new features, improve the documentation, and fix bugs. To correctly install updates only the
Updating the Studio Organizer Wizard should be used. Registered users will be emailed when updates are available. A complete description of the
updating process is in the built in Help.
Also, student photos will not transfer to new versions if they are not stored in the correct folder. All photo images must be stored in the Student
Photos folder.

Close Buttons & Window Resizing
The standard close buttons at the top of windows are disabled. Instead, the Studio Organizer has Close buttons at the bottom of most screens, or a
small red Close dot in the top right corner of a window. Most windows are resizable, however window resizing is inconsistent on Windows
computers. To work around this issue select a Resizing Windows preference on the General folder tab of the Preferences screen.

Quickbooks & Accounting Software
The Studio Organizer does not integrate with Quicken, Quickbooks or any other accounting software. I have worked with many studio owners who
have used other software products that offer 'Quickbooks integration.' The feedback is always the same -- it's more of a marketing gimmick than a
workable solution. It's expensive, unreliable and time consuming. A far simpler solution exists. Instead of attempting to duplicate invoices and
payments, you can use the Studio Organizer to create invoices for all of your sales and tuition. When it's time to place that information into your
accounting software, run the Invoices, Invoice Items or Sales Tax reports in the Studio Organizer then enter the totals into your accounting software as
a single journal entry. You can now use your full featured accounting software for tax reporting purposes, etc. This is fast, easy, and hassle free.
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Technical Support

Email Technical Support is FREE!
The Studio Organizer is designed to be easy to use, but it's still computer software and understanding how to make it work
for you means asking questions and getting answers. That's why email technical support is offered free of charge.

In order to receive free email technical support just click the Support button on the screen where your question occurs. Or
select Technical Support from the Wizards or Help menu.

This will start the Smart Support Wizard. It's a powerful tool that will help you gather all of the essential information:
1) what you are attempting to do 2) the steps you are performing  3) the exact text of the error message.

Your Data is Not Included
Using the Smart Support Wizard is essential, however this does not show technical support the data on your computer screen.
To do this you can take a snapshot of the screen and include it when you use the Smart Support Wizard. It's also possible to
send snapshots by following the Sending A Screen Snapshot instructions in the built in Help. In some cases, technical support
may request your data files. This is often the only way to resolve certain problems.

Emailing Your Question
The Smart Support Wizard will work with any email service. Be sure to select your default email application as described in
the built in Help, the School Setup tutorial and the User's Manual. Your email application must be open and running before
sending a message.

You can even use the Smart Support Wizard if you do not have an internet connection at your school. Read No Internet
Connection At School in the built in Help.

Only the Studio Organizer is Supported
Please note technical support is only provided for the Studio Organizer software. Operating systems, hardware, and other
software programs are outside of our area of expertise.

Telephone Support
In order to keep the Studio Organizer affordable, we do not have a call center.
Sorry, telephone support is not offered in any fashion.
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Asking the Right Question

In order to help you receive the quality tech support as quickly as possible here, are a few pointers that will help you get
answers fast.

Always use the Smart Support Wizard
In order to receive fast, free email technical support please always click the Support button on the screen where your
question occurs. None of your data is included in the message created by clicking the Smart Support Wizard.

Please Be Specific
When you use the Smart Support Wizard it will help you gather the necessary information:

  1) what you are attempting to do
  2) the specific steps you are performing
  3) the undesired result or text of the error message

Please provide detailed information. The more specific, the better. The idea is to provide enough information so tech support
can duplicate your steps and see the same problem you are experiencing. Since none of your data is included when you send
an email, tech support cannot see any of your records or student information useless you send a screen snapshot or email
your data files.

If you're receiving an error message, please state the exact text of the message or include a screen snapshot.

Before you click the Send button reread your email and pretend you're someone who cannot see your computer screen or
your data. Ask yourself: "Have I given this person a clear picture of the problem I'm experiencing?" "What questions will
this person ask based on what I've just told him?"
"Are there any other details I should mention just to be thorough?"

If you have questions on several different screens, please click the Support button on each screen and send an individual
email for each question. Sending multiple Support emails is not a problem at all. There are some issues that can only be
solved if you click the Support button, so please use the Smart Support Wizard each time you ask a question.

School Setup  p. 10the Studio Organizer 5v21



Screen Snapshots & Emailing your Files

Sending a Screen Snapshot
The Smart Support Wizard allows you to easily add a screen snapshot to your message. However, networked computers
cannot use this feature because the required file is inaccessible on the server. If you would like to send a screen snapshot
manually, first complete the Smart Support Wizard and send your question. Next follow these steps to create a snapshot and
email it it to tech@StudioOrganizer.com.

Macintosh
The keyboard shortcut Command + Shift + 3 creates files on your Desktop or hard drive called 'Picture 1,' 'Picture 2' etc.
You can attach this file to an email message. Some email programs allow you paste an image directly into the message area.
Send your image to tech@StudioOrganizer.com.

Windows
Hit the PRINT SCREEN key on your keyboard. This places an image of the current screen on your computers clipboard.
Most email software programs allow you to paste directly into an email message. Paste your screen snapshot into the
message area of an email. Send your image to tech@StudioOrganizer.com.

If you cannot paste into an email message open Microsoft Word or a graphics program and paste. If asked for a file format,
select jpg or gif. Once you've created a screen snapshot file, email your image to tech@StudioOrganizer.com.

Emailing Your Data Files
In certain situations technical support require your data files. In order to correct an error or troubleshoot a problem, your data
files must be emailed to technical support.

Which Data Files do I Send?
Technical support will request the necessary files by name.

Before sending any files, please quit the Studio Organizer then compress and attach only the requested files. Also, be sure to
always use the Smart Support Wizard when requesting support.
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Email Application: Setting the Default

The Studio Organizer does not send or receive email messages. Instead, the software will transfer an email message to your
email software, then the email software will send the message. An email account and internet connection are required.  If you
are using an email application such as Windows Live, Outlook Express, Entourage, Eudora or Mail, the next step is to
designate a default email application.

For best results, be sure your email application is open and running before performing these steps or using the emailing
features in the Studio Organizer.

Windows 7 & Vista
You can use any MAPI compliant email client, such as Windows Live Mail, Microsoft Entourage or Eudora. You'll select
the default email application by going to the Start Menu, selecting Program Defaults, then single click the program you wish
to use as the default email program from the list on the left and click Set this program as default on the right.

Now you can click Choose defaults for this program to customize the defaults for your email application. Click OK to save
your changes. Restart your computer.

Windows XP
You can use any MAPI compliant email client, such as Outlook Express, Microsoft Exchange or Eudora.  It may be
necessary to open your email client before sending an email.

You'll select the default email application by going to the Start Menu, selecting Set Program Access and Defaults, then if it's
not already selected, single click the Set Program Access and Defaults button on the bottom left.

Now you can click the Custom option and choose the email application you like to use and designate it as your default. Click
OK to save your changes. Restart your computer.

Macintosh OS X
Macs with OS X have an application called Mail already installed. You can also use Entourage, Thunderbird or Eudora.

To change the default email application open Mail, then go to the Mail menu and select Preferences. Click the General folder
tab and choose your email application from the Default Email Reader drop down menu. If your email application is not in
this list, click the Select menu option and an open dialog box will appear. Now find the email application and select it.
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Web Based Email & No Internet Connection

Using the Clipboard to Send Emails
If you're using America Online or a web based email service such as gmail, Yahoo, Hotmail you can use the Studio
Organizer to send email and technical support messages.

Select My Computers Clipboard is used for creating email messages on the General folder tab of the Preferences screen, or
in the Smart Support Support Wizard.

Now each time you click the Send button the email message or tech support information is copied to your computers
clipboard. Open your web browser and go to your email web page, create a new email message, click into the message area
and paste. Address the message to tech@StudioOrganizer.com.

Only one email message can be sent at a time. Sending multiple emails requires a dedicated email application such as
Outlook, Entourage, or OS X Mail.

No Internet Connection at School
Even if you don't have an internet connection at school, you can still use the Smart Support Wizard. Here's what you'll do:

Go to the General folder tab of the Preferences screen. At the very top, select My Computer's Clipboard is used for sending
email.

When you click Send from the Smart Support Wizard, the necessary information will be placed in your computer's clipboard.
Next, open a word processor and paste. Save the file and transfer it to a USB flash drive or other media.

Insert the flash drive into the computer that has an internet connection and open the file, then select and copy all of the text.

Now open your email software, create a new email message and paste the text into the message area of the email.

Address the email to tech@StudioOrganizer.com.
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the Built In Help

The Help system can be accessed from most screens by clicking the Help button in the top right corner.

Use the Category drop down menu to select from a variety of topics.

Single click directly on a title from the list on the left to display the text.

To search the Help files, type what you're looking for into the Search field in the bottom left corner of the
Help screen, then click the Go button.

Click the Print button to print a Help topic.

Much of the information you're about to read in these tutorials is directly from the Help system build into
the Studio Organizer.
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Transferring Your Data to Another Computer

Here's a very popular feature of the Studio Organizer...

Transferring Your Data to Another Computer
The Studio Organizer is designed to help you quickly and easily move your data between two computers.
The Transferring Files Wizard will walk you through the process. All you'll need is a USB flash drive.

This is a very popular feature that many school owners use to bring their Studio Organizer data home for
the evening. After using the Studio Organizer at home, you can run the Wizard again to transfer your data
back to the school computer the next day.

The Transferring Files Wizard is also what you'll use to move your Studio Organizer data if you'd like to
move your data to a different computer.

The instructions for Transferring Files are built into the Studio Organizer. Just click the Help button on the
Student Info screen, then select "Transferring Files" from the drop down menu of help categories in the
upper left corner of the screen, then click on "...to a New Computer" and "...between school and home."

Your Registration Code transfers when you use the Wizard.
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Installing the Studio Organizer

Windows
If you have a CD, insert and the installer will begin automatically. If you've downloaded the installer from the web
site, locate the download file on your computer.

Double click Setup_tSo5.exe and follow the on-screen instructions. The software will be installed on your Desktop.
You can move the Studio Organizer to your My Documents or a shared public folder if you wish. Do not move the
Studio Organizer to the Program Files folder.

Macintosh OS X
If you have a CD, insert and open the CD, then open the Macintosh folder. If you've downloaded the installer from
the web site, locate the download file on your computer.

Double click Install_tSo5.zip archive. The archive will uncompress and create a Studio Organizer folder in the same
location as the Install_tSo5.zip file, or the Downloads folder. You can move the Studio Organizer folder to any
location you wish. You can also open the folder and create an alias of the Studio Organizer application and place it
anywhere you like.

Warning! Do not rename or move any Studio Organizer files or move them outside of their folder.
If you are using Dropbox, do not place the Studio Organizer folder inside the Dropbox folder. Please read Using
Dropbox To Backup Your Files  in the built in Help.

Software Installs to Your Desktop
After running the installer program, the Studio Organizer is installed on the current users Desktop on Windows
computers. This was done to prevent problems caused by a Windows Vista & Windows 7 programming feature
called "Virtualization." This is designed to protect program files from modification (viruses), however this creates a
duplicate set of files -- a major problem for the Studio Organizer users.

To avoid this problem, the Studio Organizer folder will automatically install on your Desktop. Do not place the
Studio Organizer folder inside the Program Files folder if you are using Windows Vista or Windows 7. A warning
dialog box will appear at start up if your Studio Organizer folder is inside the Program Files folder. You may move
the Studio Organizer folder to any other location you wish, such as your My Documents folder, or a shared public
folder.
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Installing on a Computer with No Internet Connection

Would you like to install the Studio Organizer on a computer that is not connected to the internet?

Option 1
If you have a computer with an internet connection and a USB flash drive you can download the installer
file and copy it to your USB flash drive.

To do this, visit www.StudioOrganizer.com and download the most current version. When asked if you'd
like to Save or Run the file, select Save and select the Desktop as the location for the file. Begin
downloading.

The installer file is called Setup_tSo5.exe for Windows users and Install_tSo5.zip for Mac OS X users.

When this file has successfully downloaded to your Desktop, copy the installer file to your USB flash
drive. You can now take the USB flash drive to the computer that does not have an internet connection and
copy the installer file onto the Desktop. Do not attempt to run the installer file from the USB flash drive.
Instead copy it to your computers Desktop, then run the installer.

Option 2
If you already have the Studio Organizer installed on one computer, you can simply copy the entire the
Studio Organizer folder to a USB flash drive, then go to the computer without an internet connection and
copy the Studio Organizer folder from the USB flash drive on to the Desktop.

The bar code font will not be installed on this computer so be sure to follow the Installing The Bar Code
Font instructions in the built in Help.
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Installation Warning & Creating a Shortcut or Alias

Avoid Duplicate Installations
The free 30 day trial and full working version of the Studio Organizer are the one in the same. If you have the 30 trial day
version, you have the full working version. Just open the software with the Master password and enter your Registration
Code and the 30 day trial limitations are removed.

Be careful not to install more than one copy of  the Studio Organizer on your computer. This can cause significant problems.
See Install Only One Copy Of The Studio Organizer at the beginning of this tutorial or the built in Help for details.

Creating a Shortcut or Alias
To create an alias or shortcut of the Studio Organizer application, open the Studio Organizer folder on your hard drive.

Windows users: Open the Data folder.

Select the Studio Organizer 5vXX application. (XX is the version number.)

Windows users: Right click the file, then select Create Shortcut   or
Send to -> Desktop shortcut.

Macintosh users: Hold the Control key and click on the file, the select Make Alias.

Place the alias or shortcut anywhere you like. For example the Desktop or Start Menu.
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Installing QuickTime

Install QuickTime to Play the Birthday Songs
In order to play the birthday songs included with the Studio Organizer, QuickTime software must be installed on your
computer.

QuickTime is a free movie and mp3 player from Apple.

Open the Studio Organizer and select Download QuickTime from the Help menu, or visit www.quicktime.com to download
and install the latest version of QuickTime.
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Installing the Bar Code Font

The bar code font is included with the Studio Organizer and is automatically installed on Windows computers. If you have a
Macintosh computer or need to manually install the font, please follow these instructions.

Windows Users
Quit the Studio Organizer.
Locate and open the Studio Organizer folder on your hard drive.
Locate and open the Bar Coding folder.
Select the Code 39 font file and select Copy from the Edit menu. (Do not select Cut.)
Open your Control Panels, then open the Fonts folder.
Select Paste from the Edit menu.
Restart your computer.

Macintosh Users
Quit the Studio Organizer.
Locate and open the Studio Organizer folder on your hard drive.
Locate and open the Bar Coding folder.
Select the Code 39 font file and select Copy from the Edit menu.  (Do not select Cut.)
Open your hard drive, then open the Library folder.
Locate and open the Fonts folder.
Select Paste from the Edit menu.
Restart your computer.
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Bar Code Scanner Setup

The Studio Organizer is bar code scanner compatible. Using a bar code scanner to record attendance is a tremendous time
saver and well worth the investment.

When using a bar code scanner, always plug your bar code scanner directly into a USB port on your computer or a powered
USB hub. Bar code scanners draw power from their USB connection, so do not plug a bar code scanner into a USB port on a
keyboard or an unpowered USB hub. Once your scanner is connected, allow your computer to recognize the scanner. A
wizard may appear guiding you through this process.

If you are using a Unitech MS210 bar code scanner on a Windows computer, no additional programming is required.

If you are using a Unitech MS210 bar code scanner with a Macintosh computer, it may be necessary to program your
scanner. Scan the Factory Defaults bar code on Page A-2 in the back of the MS210 manual, then scan the USB bar code,
which is the fourth one down on page A-1.

If you are using a Unitech MS146 card reader, no programming is required.

If you have a Honeywell 3800 it must be programmed to work with the Studio Organizer. The programming instructions can
be found in the Bar Coding folder inside the Studio Organizer folder on your hard drive. This special programming only
needs to be done once.

Instructions for all of the above bar code scanners are inside the Bar Coding folder, inside the Studio Organizer folder on
your hard drive and are also available on the Purchase page of the Studio Organizer web site.

Using Your Existing Scanner
If you already own a bar code scanner you'll more than likely be able to continue to use it with the Studio Organizer. For
instructions please read Programming Your Existing Scanner in the built in Help.

Creating Your Own Bar Code Designs
Please read Creating Your Own Bar Coded Items in the built in Help.

School Setup  p. 21the Studio Organizer 5v21



Launching the Studio Organizer

Open the Studio Organizer folder.

Double click the Studio Organizer icon.

Windows users: If double clicking the shortcut produces an error message, delete it, and open the Studio
Organizer folder, open the Data folder, and double click the Studio Organizer application.

Do not rename or remove any files in the Studio Organizer folders.

Entering a User Name
The first time you open the Studio Organizer, you will be prompted to enter a User Name. Enter your full
name. For security purposes, do not enter a password into the Enter User Name dialog box.

the Default Account Name
You can change the default Account Name by clicking the "Set Default Account Name" link on the
Preferences screen. It's in the lower right corner.

Enter the Master Password
Next, the Log In screen will appear. The first time you open the Studio Organizer as a registered user, you
must enter the word Master into the Account Name field.

Hit the TAB key then type the password provided in your Registration Code email.

Please do not give out the Master password to staff members. You will be able to create unique passwords
for yourself and each staff member when you create their staff record. That's something we'll do in this
tutorial.
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the Main Menu
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Buttons on the Main Menu

After the Studio Organizer opens, you'll be viewing the Main Menu. All buttons in the Studio Organizer require just a single click. Click the
Student Info or Member Info button to be taken to the primary data entry screen. From here, you can access all of the other screens.

Here's a quick run down of all the buttons on the Main Menu: The Check In button begins recording attendance. The Quick Invoice button let's you
create an invoice for an existing student. The Find Student (or Member) button presents a pick list which lets you quickly go to a students record.
The Follow Ups button will display today's follow ups. The Find Calendar button will display a calendar. The School Info, Tutorials, Preferences,
Staff, Reports and Inventory buttons opens their respective screens. The Version Check button launches your web browser and checks to see if
you're using the most current version of the Studio Organizer. The Purchase button allows you to purchase or register the software. The Go To
button let's you jump to a screen.
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the Navigation Column

From the Main Menu, single click on the Student Info or Member Info button to view the Student Info
screen. This button may also be called Member Info, Customer Info, or Client Info, depending your the
Customer Label preference you've selected on the General folder tab of the Preferences screen. Just to
make things easier, we'll use the term students through the documentation.

On the left side of the Student Info screen is a column of text. This column of text allows you to navigate to
each of the data entry screens.

Single click on the text in the left column to view a screen. For example, click on School Info to view that
screen.

The screens under Student Info are used for entering information about students.

The screens under School Info are used to customize the Studio Organizer, create staff records and
passwords as well as record expenses.

Single click the small blue arrow to the left of the Student Info or School Info headings to hide or show the
list of screens. Click the small blue arrow once to display the subheadings. Click it a second time to hide
the subheadings.

The Reports, Preferences and Main Menu buttons are fixed at the bottom of the screen.
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Before You Begin

Always Single Click Buttons
When using the Studio Organizer all buttons require just a single click. Clicking twice may result in duplicating a command.

Browsing Records with the Arrow Buttons
When you are viewing records in the Studio Organizer this is referred to as browsing. Use the arrow buttons in the top left
corner of the screen to browse through your student records.

The double left button will take you to the first record and the double right button will take you to the last record. The left
button will take you to the previous record and the right button will take you to the next record. All buttons require just a
single click. Double click, and you may end up doing something twice.

The Scripts menu at the top of the computer screen also contains keyboard shortcuts for faster browsing.

Date Fields: Enter the Year as 4 Digits
Most date fields have a drop down calendar. It won't be often that you'll type a date by hand, but if you do be sure to enter
the year as four digits. For example, enter 2/4/2010 not 2/4/10. If you enter the year as 10 older computers may
interpret this as 1910.

Date Formatting
By default dates are displayed in the format selected in your computers operating system. You can the date format to
mm/dd/yyyy or dd/mm/yyyy using the Region & Language control panel (Windows) or Language and Text control panel
(Macintosh.) Be sure to restart your computer if you've changed your computer's date format settings.

Once your computer has been set to the correct date format, be sure to select the correct date format on the Settings folder tab
of the School Info screen. We'll address that shortly...
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The Studio Organizer allows you to view more than one screen at at time.
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Understanding Multiple Screens

As you're using the Studio Organizer, you'll notice there are a variety of screens. Sometimes when you click a button a new
window will open. When you click the School Info button, you'll see the School Info screen. Click on a style of instruction,
and a new window opens displaying a screen that displays the details of that style. Click on a rank or level, and another
window opens.

All of this makes the software easy to use -- once you know your way around. But it can also really clutter things up if you
have many windows open.

Here are few things to keep in mind:

If two or more windows are open and you accidentally click on a window you'll activate that window and possibly hide the
one you were working on. You may have to move a large window in order to get back to a smaller window behind it.

Windows can also be minimized, in which case you'll see minimized window icons at the bottom of the screen. Click the
Maximize button to enlarge a window.

The standard close button displayed on windows is disabled. Instead, click the Close button, or the small red Close dot in the
upper right corner of the screen. The main screen containing the major data entry screen has no Close button.

Be sure to click the Close button when you're done viewing a window that has a Close button or red dot. This ensures all data
is properly saved and totals are updated.

Opening a New Window
If you have a large monitor and you'd like to open one of the major data entry screens in a new window, hold the CONTROL
key on your keyboard while clicking a screen name in the left column. For example if you hold the CONTROL key whiling
clicking on the School Info screen, a new window will open.

Or select New Window from the Window menu to open the current screen in a new window. This makes it easy to view data
from different screens.

To close the new window created, hold the SHIFT key and click any screen name in the column on the left side of the screen.
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A few pointers...

Set your screen resolution to 1024 x 768 or larger for best viewing.

Keys to press on your keyboard will appear in ALL CAPS in this manual.

Hit the TAB key to move to the next field. Hold the SHIFT key, then hit TAB to move to the previous
field.

The Close buttons at the top of windows are disabled. Use the Close button or the small red Close dot in the
top right corner of the screen to close a window.

Most windows are resizable. Click and drag the bottom right corner of the window to change it's size. Also
see the Resizing Windows preference on the General folder tab of the Preferences screen.

Many menu commands have keyboard shortcuts. They are displayed to the right of the command when the
menu is displayed.

If a field has a drop down menu, it will eventually fill up with the values you've entered. So if a drop down
menu is blank, it simply means nothing has been added to this field -- yet.

If you wish to clear a drop down field, click into the field twice so the drop down menu is not being
displayed and hit the Delete or Backspace key.

There is no Save command. Your data is saved automatically when you switch screens or hit the ENTER
key in the number pad area of your keyboard.

To undo changes before they are automatically saved, select Revert Record from the Records menu. If
Revert Record is grayed out, the record has already been saved. (Sorry!)

Don’t enter data in ALL CAPS or your form letters will look like ransom notes.

Use the Delete or red X buttons to delete a record. An Admin level password may be required. Record
deletion is permanent and cannot be undone. You will be prompted to confirm each deletion.
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Entering Your Registration Code

Registered Users Only
Please print and read the entire Registration Code email. It contains everything you need to know in order
to get started with the Studio Organizer as quickly as possible. Print a copy, and keep it in a safe place.

NOTE: The Master Password provided with your Registration Code CANNOT be changed. You can
create passwords for all of your staff members, so do not reveal your Master password.

Please verify that your Registration Code has the correct school name and address before registering.

To register your software, open the Studio Organizer with the Master account name and password
provided.

If this is the first time you've opened with the Master password, you'll be asked to register the software.
Otherwise, to begin registration, click the Purchase button on the Main Menu, then click Register.

Step by step instructions for entering your Registration Code are included in the Registration Code email.
Please follow these instructions to register the Studio Organizer.

If you receive an error message, try manually entering your Registration Code as described in the
Registration Code email. If registration still fails, please click the Email button to contact technical support.
Please be sure to always use the Email button after registration fails, since the email you will send contains
essential information for troubleshooting the problem.

Suite #'s Are Not in Registration Codes
Normally, Registration Codes issued by the Studio Organizer.com do not include the second address line
which is normally used for suite numbers. On the School Info screen there are two fields for your school
address. The first address field is used to create your Registration Code, and the second address field is
optional. Please use the second address field on the School Info screen to enter your suite number or
additional address information.
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the School Info screen
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Your School Name & Address

Let's begin to customize the Studio Organizer for your school. We'll begin at the School Info screen. From the Main Menu, click the School Setup
button.

As an anti-piracy measure, your school name and address cannot be modified. Your Registration Code is created using your school name and the
first address line. If you wish to change your school name or address, please read Changing Your School Information. All other school information
fields can be modified.

Begin by entering your entire school address. Click into an address field and fill in the blanks. Use the TAB key to move to the next field. Use the
Address 2 field for your suite number if you have one. Also, be sure to select your country from the drop down list at the top of the screen.

Click the Contact Info folder tab to enter optional data such as your phone number, fax number, email address and web site.

On the Settings folder tab you can select the currency symbol, enter your Tax ID or ABN, enter sales tax rates, select letter sizes and choose your
date format. Your school motto can also be entered. All fields except Sales Tax Rates are optional. Feel free to enter only what you wish.

Changing Your School Information
Since the Registration Code includes your school name and address, if this information is incorrect or needs to be changed, simply select Change
School Information from the Help menu and sign and date the form. You can scan the form, or take a photograph of it, then attach it to an email
addressed to tech@studioorganizer.com.

All changes are subject to verification. A new Registration Code will be emailed to you and the old Registration Code will be disabled and
electronically tracked.
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Default Sales Tax Rates & School Logos

Default Sales Tax Rates
The invoice system in the Studio Organizer uses the sales tax rates you've entered on the Setting folder tab
of the School Info screen.

Always enter tax rates as decimals.
Examples: 6.5%  should be entered as  .065
                  10%  should be entered as  .10

If you use only one sales tax rate, enter that rate into the first sales tax field and leave second field blank.

If you do not charge sales tax enter zero in the first sales tax rate field.

Canadian users must enter both the GST and PST.

Users in Ontario must have "Canada" selected as the Country, and "Ontario" entered in the Province field.
Once this is done the first tax rate field will be labeled "HST." Values must be entered into both fields.

If you reside in Australia or New Zealand enter .10 in the first field only.

Invoice Boilerplate Text
Need to add the same text to every invoice? Go to the Settings folder tab of the School Info screen (or the
Invoices folder tab of the Preferences screen) and enter your text in the Invoice Boilerplate Text field.
This text will appear on all invoice and receipts.

Inserting or Deleting a School Logo
To insert your school logo, click into the blank logo field on the School Info screen. An Open dialog box
will appear. Locate the image file of your schools logo. Select and open it.

To delete a logo, click on the logo field on the School Info screen then click Delete.
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the Style & Ranks Entry screen
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Styles & Ranks or Levels

Styles & Ranks (Levels) Defined
Styles of Instruction are what you teach. You could teach ballet, yoga, Hapkido, gymnastics for kids or a
stretch class. Those are just a few examples but the sky's limit. No matter what you teach, consider it a
Style.

Within each style, you may have different skill levels. Martial arts schools call these Ranks. A dance studio
might offer beginner, intermediate and advanced classes. A gymnastics school may have a variety of skill
levels. A yoga studio might not use any type of skill level system at all.

These are all possibilities and the Studio Organizer is designed to extremely flexible. The software does
have one requirement: for each style, there must be at least one rank or skill level. Also, although students
can be enroll in many styles, they must only be enrolled in a Style once. You'll understand why when you
see how the Studio Organizer keeps track of rank history and expiration information.

For convenience, the word Rank will be used through the documentation, but you can choose the
terminology the software uses on the General folder tab of the Preferences screen.
The very first thing to do is to enter all of your Styles of Instruction and their Ranks.

Enter Styles of Instruction & Ranks
To create a new style of instruction go to the School Info screen, set the drop down menu below the New
button to "Style" then single click the New button, or click + sign next to the Styles & Ranks text above the
list of styles. Enter the Style Name then enter each rank, in order, by click the Add a Rank (or Level) +
button on the  left side of the screen. Be sure to enter at least one rank or level for each style, otherwise "No
Ranks" or "No Levels" will appear in the list on the School Info screen. Once a rank or level has been
created, you can use the Edit button to modify it.

If your students can be promoted to a higher level, enter the requirements a student must fulfill in order to
be eligible for promotion to the next level. You can enter a Next Test Date, and/or enter the number of
classes, hours, points, training days (a training day = any day a student attends one or more classes) or days
attended since the student was promoted to this rank.

Leave the Requirements fields blank if this does not apply.
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Next Test Requirements Overview

Here's an overview of the fields on the Eligibility folder tab...

Next Test Date
If you will test your students on a set date, enter the Next Test Date for each rank.

Leave the field blank if you do not test on a specific date.

Requirement #1 and Requirement #2
If you test students based on the number of days, training days, points, classes or hours attended since their
last passed test, enter the number in the Requirement field, then select days, training days, classes, hours or
points from the drop down menu.

One training day = Any day a student attends one or more classes.

There are two sets of requirement fields. Leave any unused requirement fields blank.

If using more than one requirement field, select AND if both requirements must be fulfilled in order for a
student to be eligible to test. Select OR if only one of the requirements must be fulfilled for a student to be
eligible to test.

Requirements are always based on days, classes, points or hours completed at this rank and indicate what
must be done in order to be eligible to test for the next higher rank.

Some examples are on the next page...
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Next Test Requirement Examples

These examples are from the martial arts industry. Read through them to see how to apply them to your industry.

Example 1: If a White belt will test on March 1, but only if he has attended 10 classes, enter March 1 in the Next Test Date field, then select AND
from the and/or drop down menu between Next Test Date and Requirement #1. Enter 10 in the Requirement #1 field and select Classes from the
drop down menu. Leave the other unused requirement fields blank.

Example 2: If a White belt 1st Stripe student can test on March 1 if she has attended 10 classes OR 10 hours of instruction, do this: Enter March
1 in the Next Test Date field. Select AND in the first and/or drop down menu, enter 10 in the Requirement #1 field and select Classes from the
drop down menu. Select OR in the second and/or field, enter 10 in the Requirement #2 field and select Hours from the drop down menu.

Example 3: If a Yellow belt student can test on March 1 if he have attended 20 classes AND it's been 120 days since their last test, do this: Set the
Next Test Date field to March 1. Set the first and/or drop down menu to AND. Enter 20 in the Requirement #1 field and select Classes from the
drop down menu. Select AND in the second and/or field, enter 120 in the Requirement #2 field and select Days from the drop down menu.
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and/or Rank Requirements

You'll notice all of these requirements pertain to dates, hours, time, etc. What if a student must perform certain tasks, or
master a skill? These are called Points and we'll discuss them shortly. But first let's clarify the and/or options...

If you only have one requirement for a student to be able to test, do not select anything in the and/or drop down menus.
Leave them blank.

If you require a student to complete two requirements, set the drop down menu between the two requirements to AND.

If you require a student to complete three requirements, set both the drop down menus between the requirements to AND.

If you require a student to complete one of two requirements, set the drop down menu between the two requirements to OR.

If you require a student to complete any of three requirements, set both the drop down menus between the requirements to
OR.

If you require a student to complete one requirement, then one of two other requirements, set both the drop down menu
between the two requirements to OR. Set the other drop down menu to AND.

For example: Next Test Date = 3/5/10 AND 20 classes OR 30 Days

In order to be considered Eligible on the day of the test (March 5th) the student must have attended 20 classes or 30 days
must have passed since his last test.
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Training Days & Rank Comments

Training Days
One Training Day = Any day a student attends one or more classes.

Use Training Days when setting up your next test requirements for each rank if you wish to count only the
number of days a student participates in a class, regardless of the number of classes attended in one day.

For example: Bill Smith attends a 4:30 class on Monday. This would count as one training day. If he also
attended the 6:30 class, he would still only be counted for one training day. Even if he trained all day, and
attended every class available on Monday, he would only be credited one training day.

Rank Comments for Attendance Greeting screen
If you'd like to display a special comment for a rank, enter it in the "Comments for Attendance Check In
Screen" field.

These comments can be anything you wish. For example, if you type "Instructor Approval
Required" into the Comments field for this rank, this comment can be displayed on the attendance
greeting screen. The attendance greeting screen is customizable in other ways as well.

Now let's talk about Points...
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Entering Points

Do you have special tasks each student must complete before testing? Are there particular skills that must be checked off? Or perhaps a written
test, reading assignment, or community service is required before a student is considered eligible for promotion. The Points folder tab is where you
can add any task oriented requirements and assign a point value.

To create a Point, click on the Points folder tab on the Edit a Rank (or Level) screen, then click the Add a Point + button. You can now type in a
description of the Point, assign a sorting order, point value and even insert an image, movie or document in the Image field. When assigning a title,
try to create unique wording for each Point. This will be very helpful when it's time to record completed points and you have many to choose from.

If a particular point is of greater value, assign it a higher point value.
If a point is mandatory, assign it a point value higher than all the other points at this level or rank combined.
If a point is changed at some point down the road, be sure to click the Apply Changes button.
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Inserting an Image or Movie

You can insert images or small movies files into a Point or Curriculum entry. It is recommended you set your camera to the lowest resolution
available. The size of the image field is 150 pixels wide by 180 pixels tall, but the image will reduce or enlarge to fill the image field.

Transfer the image or movie into the Student Photos folder inside the Studio Organizer folder. Go to the Curriculum or Point record and single
click on the empty image field. An open dialog box will appear. Select the movie or image file from the Student Photos folder.

Please be sure to leave the "Store only a reference to the file" box checked.
Network users: You may uncheck the "Store only a reference to the file" box, but do so with caution. See the Networking instructions in the
Working with Data tutorial.

Once Points have been created, they can be added to a Class as curriculum. (Keep reading...) You can also record quickly completed Points on a
Students Style Details screen or using the Record Points Wizard. (See the Guided Tour for details.)
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Adding More Ranks or Levels

Now that you've completed your first rank, to enter the next rank, click the New Rank (or New Level)
button. Or even better, use the Duplicate button which will allow you duplicate the points for this rank if
you wish.

Martial arts users: be sure to include every stripe in a rank if they each require a test or grading. For
example:
White Belt, White Belt - Stripe 1, Yellow Belt, Yellow Belt - Stripe 1, Yellow Belt - Stripe 2. Enter each of
these as individual ranks. The Duplicate button will be a real time saver.

Please note: If you add or delete a rank after students have been enrolled in this style of instruction, you
may have to manually correct the ranks of those students.

Once you've entered all of your Styles, any time you wish to review or modify them just go to the School
Info screen and single click directly on the Style Name in the list.

To delete a style, click the red X. An Admin level password is required.

the Replace Buttons
Once you have created all of the ranks, you can quickly modify all of your rank requirements by using the
Replace buttons. They have a green check mark.

First, modify the Next Test Date and other Requirement fields, then click the green Replace button to the
right of that field to apply those changes to all the other ranks. These changes will be applied to every rank
in this style.

Replace changes cannot be undone. Use the Replace buttons with caution. (Run the Backup Snapshot
Wizard first!)
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Almost Eligible & Expiration Fields

OK, let's close the Edit a Rank (or Level) screen and return to the Styles & Ranks entry screen.

After you've entered all the Ranks for a Style, let's look at the Style Preferences folder tab. We'll start with the Almost Eligible & Expiration fields.

The Almost Eligible & Expiration fields on the Style Preferences screen allow you to determine when a student is approaching expiration or his
next test. You can select when a student will be flagged as almost eligible or almost expired by entering a number of days, classes and/or hours.
This is a very powerful feature which will warn you in advance if a student is about to expire. It will also help you prepare students who are close
to meeting their test requirements. Here are some examples:

If you enter 5 into all of the Almost Eligible & Expired fields, any student who is within 5 days, classes or hours of expiring will be flagged as
Almost Expired. This text will appear under their photo, on the attendance greeting screen, and in other places. These students will be included in
the Expiration report.

Students who are within 5 number of days, classes or hours of a test will be flagged as almost eligible to test and they will be included in the
Promotions Test List and Promotions Wizard.
If AND is used between two rank requirements, the student must be almost eligible for both requirements before he will be flagged as almost
eligible. If OR is used, when either requirement is met the student will be considered almost eligible.
A student is considered almost eligible when he has completed 75% of the required points.

A student becomes eligible to test when the next test date arrives, or they have completed the required number of points, days, classes or hours.

The entries that you make in the Almost Eligible & Expiration fields on the Style Preferences folder tab on the Style & Rank screen will apply to
every rank in this style of instruction. Some examples are on the next page...
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the Almost Eligible & Expired Fields

Within X Days
Enter the number of days prior to a test date or expiration date this student should be flagged.
For example, Bill Miller will be testing on April 20th. Enter 10 in the Almost Eligible & Expired Days field and on April 10th he'll be flagged as
almost eligible to test. On April 20th that will change to eligible to test. Bill will be flagged as about to expire when he's within 10 days of his
Expiration Date.

Within X Classes
When a student is within X classes of expiration or being ready to test, flag this student.
For example, Suzie Brown needs to attend a total of 50 classes before being eligible for promotion. Enter 7 in the Almost Eligible & Expired
Classes field and when she's attended 43 or more classes she'll be flagged as almost eligible to test. When she's attended 50 or more classes, that
will change to eligible to test. Suzie will be flagged as about to expire when she has 7 or less classes remaining.

Within X Hours
When a student is within X hours of expiration or being ready to test, flag this student.
For example, Eddie Steven's needs to attend a total of 50 hours before being eligible for promotion. Enter 5 in the Almost Eligible & Expired
Hours field and when he's attended 45 or more hours he'll be flagged as almost eligible to test. When he's attended 50 or more hours, that will
change to eligible to test. Eddie will be flagged as about to expire when he has 5 or less hours remaining.

75% of Points
There is no Almost Eligible field for points. When a student has completed 75% of the required points, the student will be flagged as Almost
Eligible.
For example, Jeff Jones needs to complete 100 points to be eligible for promotion. When he has completed 75 pr more points he will be flagged as
almost eligible to test. When he's completed 100 or more points that will change to eligible to test.
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Limiting Check Ins per Day, Week or Month

Let's move to the next set of preferences...

You can limit the number of times a student checks into a class using this style of instruction. You can
control the number of self check ins for each day, week and month.

The default number of times a student can check themselves into a class in each style of instruction is set
on the Style Preferences folder tab of the Style & Rank screen. The settings you choose here are
automatically entered when a student is enrolled into this style of instruction, but can be changed for each
individual student. If you alter the Self Check In fields for an individual student those change will always
override the default settings for the style.

Here's an example: Bill Smith is enrolled in Hapkido, and the default check in number is 1, but Bill's Check
ins per Day field on his Style Details screen is set to 3, Bill will be allowed to check into 3 Hapkido classes.

Students enrolled in more than one style can check in according to the settings for each style. For example,
if Jane Miller is enrolled in both Hapkido and Kung Fu, and the default Self Check Ins per Day is 1 for
Hapkido and 2 for Kung Fu, Jane could check into 3 classes in one day: 1 Hapkido plus 2 Kung Fu classes.

Don't worry about that last part if you're confused. We haven't talked about the Style Details screen yet. It's
covered in the Guided Tour and User's Manual.

Just know the Self Check In fields used here are the default, but they can be changed on a student by
student basis.
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Attendance Rating

Attendance Rating is an optional feature. To turn enable Attendance Rating, go to the School Info screen and click on a style of instruction, then
click on the Style Preferences folder tab. Set the Attendance Rating field at the bottom of the screen to On if you wish to use it. If you do not wish
to rate student attendance, set the Attendance Rating drop down menu to Off.

Select the number of days used by this feature. If you would like to evaluate attendance based on the past 10 days, enter 10 in the Days field.  Use
the remaining fields to enter the number of classes a student must attend for the Great, Good, Fair and Poor ratings.

Once you have begun to record attendance for a student the Attendance Rating is displayed on the Check Ins folder tab on the Style Details screen.
Or you can go to the Styles, Classes & Attendance screen and hold the mouse over the status field in the style of instruction area until the yellow
tool tip is displayed.

If a student has not attended any classes within the number of days specified, the Attendance Rating for that student will display None.
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the Style Logo

On the Style Preferences folder tab of the Style & Rank screen you can insert a logo for each style of
instruction.

To insert your school logo, click into the empty Style Logo field and an Open dialog box will appear.
Locate the image file of your schools logo. Select and open it.

To delete a logo, click on the logo field then click Delete.

Student ID cards can be set to print the School Logo, the Style Logo, or No Logo. Select the logo you wish
to print from the drop down menu below the Style logo.

School Setup  p. 47the Studio Organizer 5v21



More about Ranks & Styles

Adding and Reordering Ranks
Click the Up or Down arrows to reorder the ranks of a style of instruction. Doing this will change the ranks of students
already enrolled in this style of instruction.

If at some point down the road you add a rank, put the ranks in the correct order first, then go the Style Details screen of each
student in this rank and verify they have the correct rank selected.

Modifying Rank Requirements
If you modify a rank requirements after students have been enrolled in that rank, be sure to Reset the Next Test
Requirements fields. See Reset Button: Refreshing Rank Requirements in the built in Help for details.

Deleting a Rank
In order to delete a rank, go to the Ranks folder tab of the Style & Rank screen and click the red X next to the rank you wish
to delete. An Admin level password is required.

A dialog box will appear asking you to move the students at this rank to the next lower rank, or the next higher rank, or make
no changes. Styles of Instruction and attendance are then automatically updated to reflect this change.

Renaming Styles
Styles can be renamed at any time. Just click into the Style Name field at the top of the Styles & Ranks screen and make your
changes.

Create an Open Style for Open Classes
If you have a classes which is open to all students regardless of their style of instruction? For example a Stretch class or an
Open Mat class?

If so, create a new style of instruction and name it Open. Now you can create an Open Mat class and select Open as the style
of instruction. You can also enroll students in this style so they can check into these classes.

After you've entered all of your Styles & Ranks, click the Close button to return to the School Info screen.
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Entering Classes
Once you're entered all of your Styles of Instruction and Ranks or Levels, you can begin to enter your Class
Schedule. You don't have to enter them all right now, you can enter just a few classes to get started...

From the School Info screen set the drop down menu below the New button to "Class" then single click the
New button or click the + button to the right of Classes. Enter the class name and complete the additional
fields.

When entering times, you can type '8 pm' and 8:00 PM will be displayed. When you end both a Start Time
and an End Time the Total Time is automatically calculated. The Total Time field cannot be edited.  If you
teach the same class at different times, use the Duplicate button to create one record for each class, then
alter the starting time.

Fields such as Location and Group have self populating drop down menus. The drop down menu will
eventually fill up with the values you enter into the field. If a drop down menu is blank, it simply means no
entries have been made in this field yet.

The values you enter into the Location field are used to populate the Location drop down menu on the
Student Info screens.

Groups can be anything you wish: Adults, Teens, Children, Tiny Tigers, or anything else.

Be sure to select a style of instruction. Without a style of instruction, attendance cannot be properly
recorded for the class. Only one style can be selected per class. If you teach the same class but more than
one style can attend, use the Duplicate button to create a class record for each style.

Selecting the Lowest and Highest Ranks are optional.

If you wish to clear a field that uses a drop down menu, for example the Style of Instruction and Ranks
fields, click into the field twice, then hit the Delete or Backspace key on your keyboard.

Use the Sort # field to set the order classes will be listed in the Class Schedule report. If the Sort # field is
left blank that class will appear at the top of the report. If you'd like your class schedule to display
children's classes first, enter low numbers into the Sort # field for those classes.
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Class Info

The Class Info screen
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Entering Curriculum

Once you've created a class record, you can make a list of the things you would like taught in this class. Click the Curriculum folder tab, then click
the Add Curriculum  + button. This opens the Edit Curriculum window.

Here you can type in any skills or topics you'd like your instructors to cover. You can select a Sorting Order and Point Value. You can also insert
an image or small movie.

You can create a unique curriculum entry, or choose an existing point you've created for a rank. To select an existing Point, single click the small
blue arrow to the right of the Title field. You can select a Points from any style or rank. This list can get rather long if you have many Points, so
you'll be glad you used unique and descriptive titles when you created these points.

If a Point has been selected, you can view of modify it by clicking the Edit button. Be advised, if you make changes to original Point record, be
sure to click the Apply Changes button if you would like all students or classes using this Point will have the new information.

Once you've created a Curriculum entry, use the New Item and Duplicate buttons to quickly create additional curriculum entries.
Here's an extremely helpful feature: when a class is duplicated, you will be given the option to duplicate the curriculum as well.
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Saved Class Lists

The Saved Class Lists feature allows you to quickly enroll students into many classes by creating lists of
classes. When it's time to enroll a student in classes you can select a Saved Class List, and with one mouse
click enroll that student in all classes in that list. You can create names for your lists, and classes in a Saved
Class List can be in different Styles of Instruction. Each class can be in as many Saved Class Lists as you
wish.

For example, let's say Hapkido White belts normally enroll in these classes:

Hapkido - M W F at 8 p.m.
Hapkido - T Th at 7 p.m.
Stretch - Saturday at noon.

To create a Saved Class List for our Hapkido White belts, go to the class record entitled Hapkido - M W F
that starts at 8 p.m and click the Add Hapkido - M W F to a Saved List button then type in a unique name
you wish to assign to this list. For example, type "Hapkido White Belts."

Next, use the blue arrow buttons at the top left corner of the screen to go to the record for the Saturday
Stretch class, click the Add Stretch to a Saved List button. A selection window will appear. Click the down
arrow to select "Hapkido White Belts." This drop down list is self populating; it will contain the Saved
Class List names you've previously entered. Repeat these steps for the Hapkido - T Th class as well.

To delete a class from a Saved Class List, click the red X. (An Admin level password is required.)

You can print a report of your Saved Class Lists by selecting Saved Lists from the drop down menu below
the Print button, then clicking the Print button. Or go to the Report menu, select the Classes category, then
clicking on Saved Class Lists.
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Your Class Schedule & Special Teams

Enter as many classes as you wish. Just be sure to come back to the School Info screen and enter your
entire class schedule at some point.

You can print your Class Schedule by selecting Schedule from the drop down menu below the Print button,
then clicking the Print button.

Once you're done entering classes, you can return to them by going to the School Info screen and click
directly on the Class Name in the list.

To delete a class, click the red X. (An Admin level password is required.)

Posting Your Class Schedule on Your Web Site
You can export your class list, then place it on your web site. This requires an understanding of web design
and HTML. Please read Posting Your Class Schedule On Your Web Site in the built in Help under the Class
Info category.

Entering Special Teams
Let's move on to Special Teams. If you do not have Special Teams at your school, skip this.

Special Teams can be created and edited on the School Info screen.

To enter a new Team, go to the School Info screen and set the drop down menu below the New button to
"Team" then single click the New button, or single click the + button to the right of Special Teams.

Enter the Team name. Click Save & Add Another to continue entering Team names. Hitting the ENTER
key on your Number Pad is the same as clicking this button.

To edit a team name, go to the School Info screen and click directly on the Team name.

To delete a team, click the red X. (An Admin level password is required.)
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The Continue, New and Close Buttons

Here's a few helpful tips which will save you some time while you're entering data.

If you're viewing a dialog box with a Save & Add Another button, hitting the ENTER key on the number pad area of your
keyboard does the same thing as clicking on the button with your mouse.

This has been done to make repetitive data entry faster. Your hands don't have to leave the keyboard to reach for the mouse.

Clicking Save & Add Another saves the current data you've just entered and creates a new record.

The New Button
Also, on just about every screen, you'll click a New button to create another style of instruction, Class, etc. Some New
buttons have drop down menus below them to let you select from a number of options.

The Close Button
After you're done entering Styles of Instruction, or Classes, you'll click the Close button to return to the previous screen.
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Sticky Notes

Before you leave the School Info screen, here's a helpful tip...

As you pause your mouse over a field or button a yellow sticky note will appear providing information about the item.

Move the mouse away from the field to make the sticky note disappear.

Not all fields or buttons have sticky notes.

There is a brief delay before sticky notes are displayed.

Currently, it is not possible to change the length of this delay or disable sticky notes.
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Finding Records

Some database systems use the word query but we'll use the term find when referring to searching your records.

QuickFind
The QuickFind feature searches all fields at once. Select "QuickFind" from the drop down menu below the Find button and search ALL
data fields with one mouse click.

the Find Button
First, be sure to set the drop down menu under the Find button to Records then single click the Find button. You are now in find mode,
and you'll notice all the fields appear blank and the screen names on the left have disappeared. This reminds you you're in find mode.

Click into any field and type what you'd like to search for. This is called your find criteria. For example, click into the last name field
and type Smith. Your find criteria is last name = Smith. To perform the find, single click the Find button again. To exit without
performing a find, select Browse Mode from the View menu at the top of the screen, or click the find button again. Do not remain in
find mode, otherwise you could mistakenly begin to enter more records. Anything you type while in find mode is not saved.

The Found Set
After successfully performing a find, you create a found set which contains all of the records matching your find criteria. After
performing a find, take a look at the text under the arrows in the top left corner of the screen; the number of found records is now
displayed. This is called the found set. Think of all of the records in your database as a complete deck of cards, and the cards in your
hand as the found set.
Once you have created a found set, you can only browse the records in the found set. When you're playing cards, you can only see the
cards in your hand. Once you have a found set of records, you can now create emails, do a mass mailing, print envelopes etc. Click the
Show All button to undo the found set and browse all records. Think of this as picking up the entire deck of cards and viewing all of
them. Also, you should know that when you perform a find, you're searching all records, not just your found set.

Using a Pick List to Find a Student
Another way to quickly jump to a student is to single click the Pick List button, then single click on the students name. No found set is
created when using the Pick List button.

Find Matching Records
Here's a useful tip for searching for data in fields. Click into a field and highlight some text. This becomes your find criteria. Next, right
click (PC) or Control click (Mac) and select Find Matching Records from the contextual menu that appears. This will find all records
that match the find criteria in the field you've selected and create a found set.
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Printing the Found Set

IMPORTANT!
This is a something you'll want to be sure everyone who will be using the Studio Organizer understands.
This is a very common tech support question, so please read this information carefully.

Once you have successfully performed a find, you now have a Found Set.
Understanding the found set is very important when it's time to print. There are two options in your print
dialog box:

Records Being Browsed
Select this option to print the entire found set.
If you have not performed a find and do not have a found set, all records will be printed.

Current Record
Select this option to print only the one record you’re looking at when viewing a form, or if you're viewing a
list or report, the current record is the one with the black bar on the far left side.

Invoices are the Exception
Always select Records Being Browsed when printing invoices.

Macintosh Users
In order to see the Records Being Browsed or Current Record option it may be necessary to select the
Studio Organizer or FileMaker Pro from a drop down menu in your print driver software.

the Preview Button
Many reports and screens have a Preview button. Click this button to see how the report or screen will
print. This is important because some reports will print slightly differently than what you are seeing on the
screen. This is especially true if a report has a variety of sorting options, or subtotals by category, class,
date, etc.
Try different sorting options then click the Preview button to see how report will print.
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the Inventory screen
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Entering Inventory

Now let's begin to enter some of your inventory items. You can enter as many records as you wish now, or
come back and add more later. This might be a task left to staffers during slow times or a trustworthy
student that needs to earn some brownie points.

To create a new inventory record go to the School Info screen and set the drop down menu below the New
button to "Inventory" then single click the New button, or click the + to the right of the word Inventory. A
blank record will be created with an automatically assigned a random inventory number.

Inventory Numbers
Inventory numbers must be unique. The easiest way to handle inventory numbers is to use the random 12
digit number already assigned, or you can use the bar coded number already on the item. If you have a bar
code scanner, click into the Inventory # field, then scan the bar code that's on the item. This will enter the
bar coded number into the field.

If you're going to assign your own Inventory #'s here are the requirements:

Inventory # Bar Codes cannot exceed 12 characters. Always test your bar codes to be sure they scan
properly.

USE ONLY THESE CHARACTERS
A-Z Upper Case only     0-9 (numerals)     - (minus sign)     . (period)     $ (dollar sign)     / (forward slash)
+ (plus sign)     % (percent sign)

DO NOT USE THESE CHARACTERS
lowercase letters     Space     Carriage Return     \ (backslash)     ; (semicolon )     : (colon)

Opening Inventory
You can open the Inventory module by going to the School Info screen and clicking on an inventory item
from the list on the right or by clicking the Inventory button on the Main Menu. Inventory can also be
opened from the Invoice Entry screen by clicking the inventory pick list folder tab on the right and clicking
the Open Inventory button at the bottom. Once inventory is open to add an item click the New button.
Remember, all buttons require just a single click.
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Inventory Quantities

List View
On the Inventory screen, click the List View button to view your inventory items in a list.
To return to viewing a single item, click the image of the item or the View button on the right side of an
item, or the Form View button at the top of the screen.

Quantity in Stock & Minimum Quantity
Set the Quantity in Stock field to the number you currently have of this item.
Set the Minimum Quantity field to the fewest number of an item you want to have on hand.
When the Quantity in Stock is less than the Minimum Quantity, the words Time to Reorder! will appear on
the screen for this item.

The item will also display a pink background on the Inventory pick list of the Invoice Entry screen if it's
time to reorder, and a red background if there are zero items in stock.

Re Order Inventory Wizard
If the Quantity in Stock is less than the Minimum Quantity, Time To Reorder! will be displayed. Or you
can check the "Reorder this Item" check box to display the Time To Reorder! message for this item and
include it with the other items that need to be reordered.

Click the Reorder button at the top of the screen to find all inventory items that need to be reordered. Or go
to the Wizards menu and select Reorder Inventory.
Set the drop down menu below the Print button to Wholesale Price List then click the Print button to print a
list of items to reorder.

Do Not Deduct Quantity Check box
Each time you print an invoice, the sold items are deducted from inventory by reducing the Quantity in
Stock field.
For service items, such as tuition or late fees, check the Do Not Deduct Quantity check box to prevent a
negative Quantity in Stock from appearing.
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Inventory Categories & Inserting an Inventory Image

Inventory Categories
You can create as many categories for inventory items as you wish. The Category drop down menu is self
populating. The items in the menu are a list of every entry made into this field. It will be empty until you've
entered at least one category. Each additional category you type into the field will be added to the menu.

Important Note Regarding Tuition
The word "Tuition" should always be used as the category for inventory items related to tuition or
membership fees. This is a requirement for proper display of tuition items on the Invoice Entry screen and
pick lists.

Inserting an Inventory Image
First, take a picture with your digital camera or copy an image from the manufacturer's web site.

It is recommended you set your camera to the lowest resolution available. The size of the image field on the
inventory screen is 150 pixels wide by 180 pixels tall, but the image will reduce or enlarge to fill the image
field.

Next, transfer the photos from your digital camera or move the images you'd like to use into the Student
Photos folder inside the Studio Organizer folder.

Now go to the inventory record and single click on the empty image field. An open dialog box will appear.
Select the photo or image file from the Student Photos folder.

Please be sure to leave the "Store only a reference to the file" box checked.
Network users: You may uncheck the "Store only a reference to the file" box, but do so with caution. See
the Networking instructions in the Working with Data tutorial for details.

When it comes time to insert Student and Staff photos, please carefully read the instructions. If your photos
are not stored in the Student Photos folder, they will not transfer properly when transferring files between
computers or updating to a new version.
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Sales Tax in Inventory Entry

If an item is not to be taxed, select No from the drop down menu in the "Taxable Item?" field.

Always enter tax rates as decimals. If your sales tax is 6.5%, enter .065 into the sales tax field.

When a new inventory record is created, the Studio Organizer uses the default tax rates as they are entered
on the School Info screen, but you can change the tax rates for each item on this screen if needed. Simply
edit the tax rates in the % column, then hit the TAB key.
If the "Taxable Item?" field is set to a taxable option, sales tax and the price fields will be recalculated.

The Studio Organizer calculates two tax rates to accommodate Canadian users, or bracketed tax states such
as Florida.

If you live in a state or country with a single tax rate, simply disregard the second tax rate field.

Enter either the Retail Price or the Retail Price + Sales Tax, then hit the TAB key and the other price will
be automatically calculated.

Australia & New Zealand
Users in Australia and New Zealand can enter the Retail Price less GST and the Retail Price + Sales Tax
will be calculated after hitting the TAB key.
or
Enter the Retail Price + Sales Tax and the Retail Price less GST will be calculated after hitting the TAB
key.
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Inventory Print Button Options

Below the Print button on the Inventory Entry screen is a drop down menu.

Only the found set of inventory items is printed. Click the Show All button before printing if you would
like to print all items.

Select "Retail Price List" then click the Print button to create a list of inventory items with retail prices
displayed. There are two versions of this printout: brief and detailed. Click the buttons at the bottom of the
printout screen to switch between them.

Click the Preview button to see how the list will print. Items are sorted by category.

Select "Wholesale Reorder" then click the Print button to create a price list which displays wholesale costs
and reorder quantities.

Click the Preview button to see how the list will print. Items are sorted by Vendor.

Select "Names & Bar Codes" then click the Print button to create a brief list with only item names, retail
prices and the bar code for the item.

Click the Preview button to see how the list will print. Items are sorted by category.

Select "Bar Code Labels" then click the Print button to create bar code labels for the item.

Click the Print button to print the labels. After printing bar code labels, a dialog box will appear asking if
printing was successful. Be sure to click Yes, otherwise these bar code labels will remain and be printed the
next time you print labels.
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the Late Fees Inventory Record

There's one special inventory record you need to know about. It's called Late Fee and you'll use it to
determine if late fees are taxable or not taxable on invoices.

If you don't charge late fees, skip this...

NOTE: Late fees are not automatically added to an invoice. However they can be easily added or removed.
This will be explained in more detail in the User's Manual.

To set the taxable status of your late fees, open Inventory, click the Find button, type "Late Fee" in the Item
Name field, then click the Find button again. (All buttons require just a single click.)

Now you should be viewing the Late Fee inventory record.

Select Yes or No in the Taxable Item? field.

Enter the correct sales tax rates in the Sales Tax % fields.

Now any time a Late Fee is applied to an invoice (as explained in the User's Manual) the Inventory # will
automatically be entered as
-LATE-
and the correct taxable setting will be applied.

The default Late Fee amount is set on the Preferences screen, on the Invoices folder tab.

Since the Amount of a Late fee can be changed on each individual invoice, you won't enter a price in the
inventory record for the Late Fee.

Do NOT delete the Late Fee record or change it's inventory number.
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Tuition Inventory Records

To keep track of your tuition income, you will create inventory records for each type of tuition you collect.

You can add as many tuition records to your inventory as wish. To help you see where your money's coming from, create unique tuition records for
each type of tuition you collect.

For example:
Weekly Tuition $22
Month to Month Tuition $55
Annual Tuition $1125

If you wish to distinguish between NEW student tuition and RENEWING student tuition create separate inventory records. For example:

Adult Monthly New Tuition $65
Adult Monthly Renewal Tuition $65
Children's Monthly New Tuition $50
Children's Monthly Renewal Tuition $50

Just be sure "Tuition" is always entered in the Category field. This is done automatically if the word "tuition" is used in the Item Name field.
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Inventory Bar Code Labels

If you have the bar code font installed, you can create bar coded labels for your inventory items.
Labels print 30 per page: 10 down, 3 across. Use any brand of labels you wish.
To create bar code labels for an inventory item, click the image of the bar code label -- it's a button.
You'll be asked how many labels you'd like to print. The number defaults to the Quantity on Hand. Click
Continue to create the labels.

You can adjust the font and font size of the inventory bar code labels by clicking the nudge arrows.

In order to find the correct alignment settings for your printer, experiment with different gaps at the top of
the page and print on plain white paper. Hold the printed page to a label page and make any necessary
adjustments before using the label paper.

It is not necessary to print labels right away. You can create them over time, then come back to the Labels
module and print them when you're ready.

You can print on label pages which have already been used by entering the Starting Label #.
Clicking the Print button displays a preview of the labels.

After printing a dialog will appear asking if printing was successful. Click Yes to clear the Labels module
for your next session. This only deletes these labels. No inventory data is deleted. Click No to retain the
labels you have displayed, or to print them again.

Click the Close button to close the labels windows without deleting any labels.

You can enter as much Inventory data as you wish now, or come back to the School Info screen any time to
continue entering Inventory. When you're done entering inventory records, click the Close button.
Let's take a break from data entry and move on to the Preferences screen...
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the Preferences Screen

On the Main Menu or any data entry screen, click the Preferences button.

Here you can select preferences and defaults for new record creation, Starting Up, Backing Up, Attendance Check In,
Invoices, Email, Spelling and more.

At Start Up Preferences
On the General folder tab of the Preferences screen, you can select start up options. These include:

Go to the Main Menu, the Student Info screen, the transferring files screen or automatically begin attendance check in.
Sort by Last Name, Last Name & Status or Do Not Sort.
Check for Absentees, Eligible to Test, Expired or Past Due.

If any student is Absent, Eligible, Almost Eligible, Expired, Almost Expired or past due, a message will flash on your screen
when you open the Studio Organizer.

Start Up messages will only appear when you open the Studio Organizer.

Email Sending Preference
On the General folder tab of the Preferences screen, you select whether your default email application will be used to send an
email, or if the text of the email will copied into your computers clipboard.

If you're using America Online or an email service that you check by opening a web page such as gmail, Yahoo, Hotmail,
you'll want to use your computers clipboard. Now each time you click the Email button or send a support question the text of
the message is copied to the clipboard. Open your web browser and go to your email web page, create a new email message
and paste into the message area.

If you are using Windows Live Mail, Outlook Express, Entourage, or OS X mail, you'll select Default Email Application.
See Email Application: Setting the Default for details.
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the General Preferences screen
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General Preferences

Window Resizing Preference
On the General folder tab of the Preferences screen is a drop down menu that allows you to select the screen resizing options
to be used in the Studio Organizer.
Select "Use Default Window Sizes (smallest)" and windows and screens will not exceed the standard screen size of 1024 x
768 pixels. Select "Keep User Adjusted Windows Sizes" then drag the bottom right corner of any data entry screen to set the
window size you like. When possible, this size will be used as new windows are opened.
Select "Maximize Windows (largest)" and data entry screens will maximize and fill the entire screen when possible.
Maximizing on Windows computers tends to be inconsistent, especially when more than one window is open.

Backup Snapshot Preference
On the General folder tab of the Preferences screen select your backup snapshot options. Select Backup at Shutdown every 1
day and the Studio Organizer will be backed up every time you close the program. A numbered backup folder will be placed
on your desktop, unless the "Do Not Create a Backup Folder on Desktop" box is checked. Copy this folder to a USB flash
drive and take it home for safe keeping. See Backing Up in the built in Help for more details.

Customer & Skill Level Labels
The selection you make in the Customer and Skill Level Label fields will appear be used through out the Studio Organizer on
screens, reports, ID cards, etc. For example, choose Member and the name of the Student Info screen becomes Member Info.

Spell Checking
Click the Select Spelling Option link, then click on the Spelling folder tab to select your Spell Checking options.

Default Account Name Preference
You can change the account name in the opening log in dialog box that is displayed every time you open the Studio
Organizer. Do this by going to the General folder tab of the Preferences screen and clicking Set Default Account Name at the
bottom of the screen, then changing the User Name field.

Restore Print Settings Preference
The Restore Print Settings check box on the General folder tab of the Preferences screen should be unchecked if you are
receiving any type of double sided printing error. Otherwise, leave this box checked. Doing so will assure the Records Being
Browsed and Current Record settings will be correct when printing.
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Preferences - Defaults

The check boxes on the Defaults folder tab mirror those found on the Check In Options folder tab of the Styles, Classes & Attendance screen.

The Next Student # field allows you to create your own student #'s. Enter any number you wish and that number will automatically be incremented
by one. Only numbers can be used.

These defaults are not applied to existing records, only new student records created using the New or Duplicate buttons on the Student Info screen.

Absentee Preference
It's easy to flag absent students. Just go to the Defaults folder tab of the Preferences screen and enter a number in the Flag An Active Student As
Absent If Student Has Not Attended A Class For X Days field. If you enter 14, any active student who has not attended a class in 14 days will have
the word Absent appear under their photo on the Student Info screen.
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Preferences - Attendance Check In

Attendance Check In Preferences

There are many options for recording attendance. They are explained in detail in the User's Manual.

Or you can click the Help button for detailed explanations of each option.
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Preferences -  Invoices

Invoice Preferences

These preferences will make sense once you begin entering students and creating invoices. The Guided Tour will walk you through this process.

That's an overview of the Preferences. For more information about Preferences, click the Help button.
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Preferences - Interface

the Interface screen
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Preferences - Interface

Now let's customize the appearance of the Studio Organizer...

Changing the Background Colors
Click the Preferences button on the Main Menu, or in the column on the left side of the screen, then click on the Interface
folder tab.

The first column allows you to select the buttons used at the top of data entry screens. Scroll through the list, then click
directly on the button image to choose it.

The second column let's you choose button shapes and colors. Select Default, Primary, Secondary or Close. Primary and
Default are the most commonly used button classifications.

Scroll through the third column and locate a background color you like then select one of these options from the drop down
menu:

Admin
Check In
Data Entry
Dialog Boxes
Help
Student ID
Staff ID

After selecting a menu item, single click directly on the color sample to apply the color. When you select Check In, Dialog
Box, Student ID or Staff ID from the drop down menu, a window will briefly appear displaying the item with the background
selection.

The right side of Interface folder tab displays samples of each type of screen.
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Staff

Now let's go to the Staff screen. Click the Staff button on the Main Menu, or in the column of buttons on
the left side of the screen. Click the New button to create a record for each staff member. Begin to enter
data into any fields you wish. Use the TAB key to move to the next field.

Employee #'s
The Employee # is user modifiable. It can be changed at any time.
Employee #'s cannot exceed 12 characters. Use only A-Z Upper Case or 0-9 (numbers).

Phone Numbers
To add a Phone number, click the + button. Use the TAB key to move from field to field. Hit the ENTER
key to Save & Add Another. To edit a telephone number, click on it in the list.

Click on the folder tabs to enter notes, follow ups, skills, and affiliated organizations.

Print Options for Staff Info
The drop down menu below the Print button on the Staff screen allows you to print the following:

Staff Info w/ID. This prints a single page containing all staff information with an ID card which can be cut
out. There are four different Staff ID card designs. Click the numbered folder tabs above the ID card to
view the different designs.

Time Card Report. Create a report totaling this persons hours. Click the Print button to print this report.
You will then be given the option to mark all entries as paid.

Notes. Print a list of all notes for this staff member. Notes do not have a date due.

Follow Ups. View Follow ups assigned to this staff member. A date due must be entered into a note in
order for it to be considered a follow up.
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the Staff screen
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Staff

Staff Passwords
You can create unique passwords for each staff member by single clicking the Create Password button on
the Password & Access folder tab of the Staff screen. An admin level password is required.

Passwords will be discussed in detail in just a few pages...

Staff Viewing Notes
On the Staff screen, only those notes and follow ups that have the staff members name in the Assigned To
field are displayed. This is done so one staff member cannot see the notes and follow ups of another staff
member.

Changing the Color Used on the Staff ID Card
To change the color used on the Staff ID card, click on the Preferences button in the row of buttons on the
left side of the screen, then click the Interface folder tab.

Scroll through the third column and locate a background color you like, then select Staff ID from the drop
down menu and single click directly on the color sample to apply the color.

A window will open and display a sample Staff ID card so you can verify your color selection. It will close
after 4 seconds.
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Inserting Staff Photos

Please Read Carefully...
It's important to store your original student photo images inside the Student Photos folder. Failure to do so will result in
missing images after updating to a new version or transferring your data between school and home.

You'll begin this process by taking a photo with your digital camera. Web cams tend to have wide angle lenses, so for best
results use a digital camera and step in close to fill the frame with the students face.

Set your camera to the lowest resolution available. It's important to keep files sizes as low as possible. Using large images
will cause slow refresh rates when viewing records, especially for network users.

Find good lighting and take a few pictures. This image is going to seen every time the student takes out their ID card so do
your best to take a quality photo. The size of the photo image is 150 pixels wide by 180 pixels tall. Photos should be 300 KB
or less.

Next, transfer the photo from your digital camera to the Student Photos folder inside the Studio Organizer folder installed on
your computer's hard drive. The default location for the Studio Organizer folder is your Desktop.

Network users: The shared Student Photos volume should be mounted as described in the Networking instructions in the
Working with Data tutorial.

Now open the Studio Organizer and go to a students record. Click on the empty photo field or click the + button. If the
Student Photos folder is empty or contains less than 100K of data, you will not be able to insert photos. Select the correct
photo file from the Student Photos folder. Be sure to leave the "Store only a reference to the file" box at the bottom of the
screen checked, then click the Open button to insert the image. If the image file you've inserted is not stored in the Student
Photos folder, you will receive a warning message asking you to delete the photo.

Once you've inserted student photos do not move or rename the Student Photos folder or your data files. This will break the
link to the photos and they will have to be reinserted.
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Staff ID Cards

Viewing Photo Information
Hold the mouse over a student or staff photo until the yellow sticky note is displayed. The sticky note will
display information about the original file, such as it's size and location.

Printing Staff ID Cards & info
To print Staff ID cards set the drop down menu below the Print button on the Staff screen to "Staff Info
w/ID."

Click the Print button.

This will display a full page staff information sheet that you can print for your records.

There are four different Staff ID card designs. Click the numbers above the ID card to view the different
designs.

Print this page, then cut out the ID card.

You can laminate these ID cards using 3M Scotch Business Card / ID Protectors (LS851.)
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Staff Clocking In and Out

Staff members can clock in or out while students are using the attendance check in feature to check
themselves into class. There are several options for checking in and out, depending on the hardware you are
using.

Bar Code Scanner
If attendance is being recorded using only a bar code scanner, staff members can clock in or out by
scanning a Clock In or Clock Out bar code prior to scanning their ID card.

To print out the Clock In and Clock Out bar codes, go to Reports menu, select ID Cards from the Category
menu, then single click on Bar Codes. Click the Create It button to print the Bar Codes page. Place this
page next to your bar code scanner. Now staffers can scan the Clock In or Clock Out bar code, then scan
the bar code on their Staff ID card.

Hand Typing the Employee #'s
Type "cin" (no quotes) then the Employee # to Clock IN.
Type "cout" (no quotes) then the Employee # to Clock OUT.
Next, the employee has three options:
1) They can enter their Employee # as displayed on the Staff screen.
2) They can enter the password they use to open the software.
3) They can enter the passcode assigned to their student record, provided the Student # and the Employee
#'s are the same. (Please read When A Staffer Is Also A Student for details.)

Some examples:
If a staffers Employee # is "1231" he can enter "cin1231" (no quotes) to clock in.
If a staffers log in password is "teacher789" he can enter "coutteacher789" (no quotes) to clock out.
If a staffers passcode for his student record is "speedy" he can enter "cinspeedy" (no quotes) to clock in,
provided the Student # of his student record is the same as his Employee # in his staff record.

Touch Screen
If students are using the touch screen feature to check into class, staffer can touch the In or Out button then
enter their Employee #, their password, or the passcode assigned to their student record, provided the
Student # and the Employee #'s are the same. (Please read When A Staffer Is Also A Student for details.)
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When a Staffer is also a Student

There's a fourth Time Clock option which does not use the Attendance Check In feature.

Recording Hours from the Staff Screen
If a staff member forgets to clock in or out, you can easily add a time card entry. Just go the Staff screen,
find the staffers record and click the + button on the left side of the screen in the Time Card entries section.

Enter a date and time, then select In or Out. Hit the ENTER key on your keyboard, or click Save & Add
Another to add more time card entries for this staff member. Click the Save button to exit.

When a Staffer is also a Student
If you have a staff member who is also a student, you can issue them one ID card which can be used both
for classes and for clocking in and out.

To do this:

1) Create a student record for this person and make a note of the Student # on the top right corner of the
Student Info screen.

2) Create a staff record for this person, and CHANGE the Employee # to this person's Student #.

3) Click the Print button on the Staff screen and select an ID card design.

4) Print the Staff Information sheet, then clip out the ID card.

For this staff member, class attendance is recorded just like any other student.

Clocking in and out is requires scanning the clock in or clock out bar code. See the previous page for all of
the clocking in and out options.

Now that you have entered your Staff members, let's create user names and passwords for staffers that will
be using the Studio Organizer.
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the Passwords & Access screen
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Creating Passwords

Only the Master password or an Admin level user can create passwords.

Only use the Master password to register, transfer files, and update the Studio Organizer. To create your
own password, go to the Staff screen, create a staff record for yourself, then click the Create Password
button on the Passwords & Access folder tab. Be sure to give yourself Admin access. Then, DISABLE the
Master password.

Next, go to the Staff screen and create a record for each person who will be using the Studio Organizer.
Click the Create Password button on the Passwords & Access folder tab and create a password for each
staff member. Passwords are CASE SENSITIVE and must be at least 4 characters.

The Admin access level has full record deletion privileges and can access the Vault.

The Staff access level has limited record deletion capability. Passwords created with the Staff access level
cannot delete Student Records, Styles of Instruction, Invoices, Inventory Items, Templates, Passwords,
Expenses, Staff Records, Classes or Special Teams. Users with Staff access cannot import, export, restore,
update, access the Vault or create a password.

When creating a Staff password, uncheck any screens you do not wish this person to view.
Uncheck the Passcodes check box if you do not wish to allow this person view Passcodes.
Uncheck the Edit Time Card check box if you do not wish this person to change their own time card.
(Clocking in and out is always permitted.)

Any user with an access level of Staff will only be able to view their own staff record when viewing the
Staff screen. All other staff records will display Access Denied fields. That's means it's safe to let staff
members view the Staff screen. They'll need to be able to see their notes and follow ups. Click Save to
create the password.

To delete a password, go to the Passwords & Access folder tab and click the red X. Or click the red X on
the Passwords & Access folder tab of the Staff screen; this will take you to the Passwords & Access screen.
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Disabling the Master Password

The Master password is only provided in your Registration Code email, but if someone were to discover this email, they could access your data.
For updating purposes, the Master password cannot be deleted. Do not give out the Master password to any of your staff members. Instead, create a
unique password for each staff member. To do this, go to the Staff screen, click on the Password & Access folder tab, then click the Create
Password button.

To disable the Master password, first create a staff record for yourself, then create a password with Admin level access and all screens viewable.
This is done on the Password and Access folder tab of the Staff screen.

Next, go to the Passwords & Access screen and check the "Disable Master Password" check box at the bottom of the screen. Enter a unique
Security Key. This Security Key can be retrieved by Technical Support, but be sure to write it down. Once the Master password has been disabled,
only the Main Menu will be displayed if the Master password is used to open the software. Quit the Studio Organizer, and reopen with the Account
Name and password you created for yourself.

Enabling the Master Password
Go to the Passwords & Access screen and uncheck the "Disable Master Password" check box at the bottom of the screen, then enter your Security
Key. Or if the "Master Password Disabled" message is displaying, hold the SHIFT key while clicking the Student Info button on the Main Menu,
then enter your Security Key. If you've forgotten your Security Key, it can be retrieved by technical support, but you must use the Technical
Support Wizard to email your request. Go to the Wizards menu and select Technical Support.

Delete the Guest Account
Registered user should be sure to delete the Guest account because the Guest password is publicly available on the web site. Protect your data by
deleting the Guest account. First create a user account for yourself with Admin level access and all screens viewable. Then click the red X to the
right of the Guest account.
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More about Passwords

Deleting a Password
On the Passwords & Access screen click the red X next to the password you wish to delete. Admin level access required. Staffers cannot delete
passwords.

Viewing or Changing a Password
Passwords cannot be displayed or changed. If a password is forgotten, delete the password by clicking the red X then create a new one.
(An Admin level password is required.)

Logging Out
When a user has finished using the Studio Organizer, go to the Main Menu and click the Quit button, then click Log Out.
or
Go to the Passwords & Access screen and click the Log Out button.
or
Select Quit/Log Out from the Scripts menu and click the Log Out button.

The log in dialog box will appear, and another user can now log into the Studio Organizer.

Change Password Button Disabled
When you first open or log into the software, there's Change Password button. This button has been disabled and should not be used. Passwords
can only be created or changed from the Password & Access folder tab of the Staff screen. To change a password, delete it and create a new one.
Admin access required. Please be sure not to give out the Master password since it cannot be changed or deleted.
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Physical Description Fields

Now let's set up some fields that are used in every student record. These are called global fields.

On the Student Info screen there are 10 physical description fields. The first six are Gender, Weight, Height, Race, Hair (meaning color, not yes or
no) and Eyes (again color.)

The four remaining fields can be use for anything you wish. For example martial arts schools might use Uniform, Belt, Glove and Shoe.

Above each field is smaller field which can be used as a label. It's light purple if it's empty. Once a field label has some text entered into it, the light
purple background goes away and the text you've entered as a label will appear in all student records. This what is known as a global field.

Customize these labels and use these fields to record the information that is relevant to you. For example you might want to records a dress size or
color preference.

The second field, which was originally "Belt" is displayed on the Test List printout.
Let's customize a few more labels...
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Display Check In Message to ALL Students

If there's a message you'd like displayed to all students during attendance check in, click the Styles, Classes & Record Attendance button in the
column on the left side of the screen and view any student record.

Click on the Check In Options folder tab on the right.

Enter your message into the "Check In Message for All Students" field in the bottom right corner.
This is another global field. If you enter text into this field in one record, that text will appear in every record.

Now, when students check themselves into class your custom message will be displayed. (Check in messages must be set to "Full Screen" or
"Show" on the Attendance Check folder tab on the Preferences screen.)

The text of the "Check In Message for All Students" field is displayed every time, for every student, until you delete the text from the field, or
change it.

The User's Manual discusses Attendance recording in detail.
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Custom Fields

Now let's go to the Custom Fields & Passcode screen...

Would like to record the last tournament or seminar your students have attended? Or an association
number? It's very likely there's a unique bit of information you need to record, but there isn't an appropriate
field in the Studio Organizer. Custom fields are the solution.

There are six custom text fields, six custom date fields, and six custom file fields. Above each custom field
is a smaller field which can be used as a label. It's light purple if it's empty. Once a label field has text
entered into it, the light purple background goes away and the text you've entered as a label will appear in
every record. (This is called a global field.)

The six custom file fields on the right can be used in two ways; store a link to a file, or store the file. When
you click into an empty custom file field an Open dialog box appears. Select a file, then check Store only a
reference to the file at the bottom of the dialog box if you wish to store only a link to the file. This does not
store the file itself, only a link to the file's location on your hard drive. This is the recommended option,
since it will keep your  Studio Organizer data file much smaller.

Uncheck the Store only a reference to the file check box if you wish to save the entire file inside the Studio
Organizer data file. The file does not have to remain on your hard drive after it's been stored in this fashion.
Use caution with this option. Although it's convenient, storing  files will increase the size of your Studio
Organizer data file. Too many files, especially large ones, are known to cause corruption.

Once you have a file linked or stored in a custom file field, to retrieve that file, click on the field and a Save
dialog box will appear. Select a name and location then click the Save button.

To clear a custom file field click the red X to the right of the field.

To print your custom field data, click the Print button. Or go to the Reports menu, select Student Info from
the list of categories, then select Custom Fields. You can also select View As Table from the View menu to
see the custom fields in a spreadsheet format that is somewhat modifiable. See Customizing A Spreadsheet
Style Report in the built in Help.
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Creating a Template

Finally, there is one last feature to customize. Click the Letters & Certificates button in the column of
buttons on the left. Take a look at the Templates column on the  right.

Templates are form letters, form certificates, and form envelopes. Templates use merge fields to insert a
students name or information into a letter, certificate or envelope. The end result is you can create
personalized documents for a group of students with very little effort.

For example, you could create a template which begins:

"Dear <First Name>" and each letter you create will insert the student's first name into the letter. If you've
used any type of mail merge software, such as Microsoft Word, you'll understand how templates and merge
fields work.

There are over a dozen sample templates in the Studio Organizer. You can scroll through the list on the
right side of the Letters & Certificates screen. Consider these suggestions. You will most certainly want to
create your own contracts, letters and certificates.

To create a template, set the drop down menu below the New button to Template, then click the New
button. Or you can click directly on the Templates text under the student number.

A blank page will appear. You can type in a name for this template, and select the default page layout
which will be used every time this template is created. There are a variety of page layouts that can include
your logo and place it in different locations. Feel free to experiment with different page layouts. You can
change the page layout at any time.

You can now begin to type the text of your template.

Inserting a Merge Field
Use the Merge Field drop down menu to view the different categories of fields. To insert a merge field
click and drag the field to into the text of the template. Release the mouse to insert the merge field in your
text.
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Fonts, Alignment, Tabs & Indents

Changing the Font, Style, Size, etc.
In letters, certificates, envelopes and templates you can select any font you have installed on your
computer, change the style, size and more. Changes made to your template will appear in the merged letter,
certificate, envelope or template.

Highlight some text, then go to the Format menu to view your text formatting options. You can also show a
text formatting menu bar at the top of the screen. To do this, go to the View menu at the top of the
computer screen and select Formatting Bar. Only the text you have highlighted is changed.

Setting Margins, Indents and Tabs
In the group of buttons at the bottom right of the template, click the Ruler button to display the text ruler,
then highlight some text. Only the text you have highlighted is affected.

Change the Left Margin: Move the bottom left arrow in the text ruler.

Change the Right Margin: Move the bottom right arrow in the text ruler.

Change the First Indent: Move the top left arrow in the text ruler.

Insert a Tab: Single click anywhere on the ruler to insert a small black tab arrow.
Click and drag a tab arrow to move it.
Double click a tab arrow to change the tab to left, right, centered or decimal tab.

In letters, certificates, envelopes and templates the TAB key will not take you to the next field. Instead it
will insert a TAB space in the text you are typing.

For more information about templates, emails, labels, letters, certificates and envelopes, please read the
User's Manual.
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Reports

The Reports Menu
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Reports

Creating a Report
There are many reports available in a variety of categories. To create a report, click the Reports button on the Main Menu.
Next, select a category from the drop down list.

Click on any of the report titles listed in the column on the left. Read the description of the report in the box on the right, then
click the Create It button.

Many reports will present a find screen. In these find screens you can select a range of dates, the style of instruction, student
name, class name or more. Enter find criteria into a field to narrow your search. Any search field left blank will not be used
in your search. All values of that field will be displayed. Read the instructions on the right of the find screen for details.

Click the Continue button to create the report. If available, click the Detailed, Brief or other buttons at the bottom of the
screen to switch between variations of the same report.

Finally, click the Preview button to see how the report will print. There are often differences between the on-screen display
of the report and how that report will print. Click Preview to see the report as it will print.

Add to Favorites
If there is a report you run frequently you can add it to your favorites list. Just select the report from the column on the left
then click the Add to Favorites + button. This adds the report to the Favorites category.

the Use Found Set Check box
The Use Found Set check box on the Reports screen allows you to create reports after you've performed a find on one of the
Student Info screens. Some reports cannot use the found set. This is noted in the report description.
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Customizing a Spreadsheet Style Report

Once you've selected a report you like, you can view it in a spreadsheet format and modify it somewhat.

To do this, go to the View menu at the top of the computer screen and make note of the current View selection. It will either be View as List or
View as Form. You'll need to know which setting you started with, so make a note of the current selection.

Next, from the View menu select View as Table. This displays the report or screen you are currently viewing in a spreadsheet format. This can be
customized to some extent. For example, you can click and drag a column heading to rearrange the columns. You can also resize a column by
moving the cursor to the right of a column and clicking and dragging when the double arrow cursor appears.

There are other options that can be selected by moving the cursor to the column headings at the top of the screen. When the cursor is on a column
heading, a small down arrow appears to the right of the column name. Click the down arrow to access this menu. Here you can sort your records,
hide fields and more. Feel free to experiment with this feature and make any changes you wish.

Unfortunately additional fields cannot be added. The report is limited to the fields that appear on the original report or screen. To return to normal
viewing, go to the View menu and select View as List or View as Form.
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Congratulations!

That's it!

The Studio Organizer is now ready for you to begin entering your students and prospects. Enter as many records as you wish,
just don't exceed 64 quadrillion records.

Keep in mind, everything you've read here is also in the Help topics.
Just click the Help button if you ever need to refresh your memory.

The next step is to read the Guided Tour. It explains how to create student records, enroll students in styles of instruction and
classes, set up tuition payments, create invoices, record attendance, perform finds, and much more.

Please print all of the tutorials and put them in a binder and keep it by the computer for easy reference.

The next few pages discuss updating, backing up, networking, technical support and computer maintenance.

Checking for Updates
You can check if your software is the most current version by going to the Main Menu and clicking the Version Check
button. An internet connection is required. Be sure to click the Version History link and read about the new features before
updating.
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Updating the Studio Organizer is Different...

When a new version of the Studio Organizer is released you can easily transfer your data into that version, but the updating
process is different than other software programs.

That's because the Studio Organizer was built using FileMaker Pro software, and oddly enough, FileMaker Inc. has never
devised a way for end users such as yourself to easily update when a version is released.

Most programming languages keep user data in one set of files, and data entry screens and reports in another set of files. So
when an update is released, all the user has to do is download the new data entry screens and reports, and a convenient
installer program puts them in the correct location. The user opens the software and all of their data appears exactly as it was,
but is displayed in the new data entry screens and reports. Simple!

FileMaker Pro, for some strange reason, keeps user data, data entry screens and reports all in one file. This means the only
way to get your data into a newer version of the Studio Organizer is to install the new version on your computer, then import
your data from the old version to the new version.

This creates a number of potential problems. First, users who have not read these paragraphs will download a new version,
open the new update, and think all of their data has been lost!

Second, users must install the Studio Organizer AGAIN, and that means two or more copies of the Studio Organizer will be
installed on the computer's hard drive. This creates a potentially confusing housekeeping chore. Users must delete unneeded
files, folders, shortcuts and aliases. If a user does not follow the updating instructions, he'll end up with multiple copies of the
Studio Organizer installed on his computer.

The third potential problem is importing errors can occur. To overcome these limitations, the Studio Organizer includes an
Updating Wizard and data verification that greatly reduces importing errors.

Knowing these limitation exist, why not use a different programming language? Because FileMaker Pro is very, very stable.
It runs remarkably well and has for over two  decades. There isn't anything else out there that's as powerful, stable and
affordable. So the updating dilemma is unfortunate, and not user friendly, but it's not a big enough fly in the soup to throw
the whole bowl away.
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Updating the Studio Organizer

You can update from any version of the Studio Organizer to the most current version. It is not necessary to install previous
updates. Your Registration Code will transfer along with your data so it's not necessary to reenter your Registration Code. Be
sure to install each Studio Organizer update when it becomes available. Updates contain new features, interface &
documentation improvements and bug fixes. Before updating, print and read the Version History on the web site for a
complete list of what's been added and how to use the new features.

Master Password Only
Even if you have created other passwords, the first time you open a new version of the Studio Organizer, you must open it
with the Master password. This is because the passwords you have created are not included in the version you download
from the web site. Any passwords you have created are transferred during the updating process and will be available after
you have successfully updated.

Updating Instructions
To update, open the Studio Organizer with the Master account name and password, then go to the Wizards menu at the top of
your computer screen and select Updating the Studio Organizer. All the instructions are right on the screen, but here's a brief
overview of what you'll do:

Step 1 Open the version of the Studio Organizer you are currently using with the Master account name and password. Go to
the Wizards menu and select Updating the Studio Organizer. Click the Begin Wizard button and read the instructions on the
screen. When you click the Begin Updating button this backups all your data and temporarily copies the backup files to your
computers Desktop.
It also locks the current version so if you were to open it accidentally you'll see an error message stating this is an old
version. (Click Unlock to open the file.)

Step 2 Next you'll be taken to the Updating web page. Follow the instructions on the screen to download and install the new
version of the Studio Organizer.

Step 3 Open the new version of the Studio Organizer with the Master password provided with your Registration Code. Click
Register Later, then go to the Wizards menu, select Updating the Studio Organizer and click Finish Wizard, read the
instructions, then click Finish Updating. This copies the backup files from your computers Desktop into the new the Studio
Organizer Data folder, deletes the backup files from the Desktop, then imports your data into the new version.
Be sure to follow the Cleaning Up instructions carefully to prevent accidentally opening the old version.
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Install Only One Copy of the Studio Organizer

This is Very Important. Please Read this Page!
It's very important to be sure you have only one functional copy of the Studio Organizer installed on your computer. Since
the 30 day trial and the full working version are the exact same files, there is nothing more to download or install when you
purchase. Simply enter your Registration Code to disable the 30 day trial limitations.

Please be sure you have not installed more than one copy of the Studio Organizer on your computer. Also, please do not
copy the Studio Organizer folder to another location on your hard drive as a backup. If you do either of these you will have
more than one functional copy of the Studio Organizer installed on your computer. This can create tremendous problems,
especially if you are unaware you are using two different copies of the software.

Sometimes users will download and install several copies of the free 30 day trial. They'll purchase, register, and begin to
enter their data into one copy, then a few weeks or months later open a duplicate copy of the software that only contains the
sample data. They'll see the software has not been registered and think all their data has been lost when it fact it's in a
different set of files.

Another problem might be a user enters ten new student records into one copy of the Studio Organizer. The next day they
inadvertently open a different copy of the Studio Organizer. Those ten records will be not be there. Users that have duplicate
copies of the Studio Organizer will email tech support and say their data has disappeared. Unfortunately there is no way to
merge or synchronize records from two different sets of files to correct this error.

As you can see, it's very important to be sure there is only one copy of the Studio Organizer on your computer. Search your
computers hard drive for "Studio Organizer"  and files with a ".tso" extension. If you find more than one Studio Organizer
folder open the Data folder and examine the modification dates of the .tso files to determine which files have been modified
most recently. Delete the Studio Organizer folder that contains the older .tso files. Also be sure to delete any aliases or
shortcuts to the deleted files. Sorry, there is no way to merge or sync data from the old files.

Finally, if you're receiving an error message stating your free 30 day trial has expired, but you know you've already
registered your software, this also means you have two copies of the Studio Organizer installed on your computer. One has
been registered, and the second has been used for entering your student information. In this case, open the version which has
all of your current information and click the Purchase button and follow the steps to register the software. Then find and
delete the other, unused the Studio Organizer folder.
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the Back Up Snapshot

Backing up is your best insurance policy, and not just from computer problems. Fire, theft, flood, lightning,
and power surges are all possible culprits. Failure to back up regularly could result in the loss of months
worth of data.

The Studio Organizer makes it easy to back up every day. To create a quick backup, go to the Wizards
menu at the top of the screen and select Backup Snapshot. This will create a folder on your Desktop
containing four backup data files. Just copy this folder to your USB flash drive. Be sure to do this every
day. It's fast and easy to backup your data.

The Backup Snapshot Wizard also creates four backup files in the Data folder of the Studio Organizer.
These are the files that are used when you run the Restore Snapshot Wizard.

Only one set of backup files is stored at a time. Each backup overwrites the previous backup. So create a
folder for storing each day's backup files, then backup that folder regularly to an external source. Keep
several days or even weeks of backups.

Please don't keep your backups only on your computer. Just in case something unfortunate were to happen
to your hard drive or computer always back up your data to an external source such as a USB flash
drive, tape drive, or external backup drive. Also, take a look at Dropbox.com. It's an excellent online
backup service and it's free for low volume customers.

IMPORTANT!
Please do not copy the Studio Organizer folder to another location on your hard drive. This will result in
more than one functional copy of the Studio Organizer being installed on your computer and if data is
entered into two different sets of files, there is no way to merge or synchronize those records to correct this
error. Always be sure there is only one copy of the Studio Organizer on your computer at all times.

The backup files created using the Backup Snapshot Wizard modified file names that prevent them from
being opened accidentally.

Also, be sure to eject backup disks or tapes, and especially Zip disks, after a backup has been completed.
This will prevent a duplicate file from being accidentally opened and used.
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Backup Snapshot Preference & Restoring

Backup Snapshot Preference
On the General folder tab of the Preferences screen select your backup snapshot options. Select Backup at
Shutdown every 1 day and the Studio Organizer will be backed up every time you close the program. A
numbered backup folder will be placed on your desktop, unless the "Do Not Create a Backup Folder on
Desktop" box is checked. Copy this folder to a USB flash drive and take it home for safe keeping.

Restoring a Backup Snapshot
In order to restore a backup, you must first have created backup files using the Backup Snapshot wizard.

IMPORTANT!
Be sure to use only the Master password provided with your Registration Code to perform these steps.
Admin level passwords will not restore your data correctly.

To restore a snapshot, open the Studio Organizer with the Master password then go to the Wizards menu
and select Restore Snapshot.

This will completely empty your files, and import the data from the backup files located inside the Data
folder. The backup files inside the dated backup folder on your Desktop are not used.
Restoring cannot be undone.

ALWAYS Backup to an External Source
Backing up is essential insurance. Computers are far from perfect. Hard drives die, computers are
vulnerable to circuit board failure, power surges, fire, theft, flood, earthquake... you name it.

Please be sure to backup your data to an external source on a regular basis. See the next page...
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What about Backup Software?

Backup software is highly recommended.

Since there are many products available ask your computer consultant for recommendations. Here are some important points
to keep in mind when using backup software:

• Always Quit the Studio Organizer before backing up.

• Always eject backup disks or tapes, and especially Zip disks, after a backup has been completed. Verify that there is no
way to inadvertently open a duplicate or backup database file.

• Ask your consultant about multiple rotating backups for maximum insurance. That means a backup tape or disk for
Monday, and entirely different tape or disk for Tuesday and so on. That way if Friday's backup has some problem, you can
always try Thursday or Wednesday's backup.

• Ask your consultant about offsite storage of your backup media.

• Ask your computer consultant to provide training for your backup and restore procedures. Your entire staff should know
how to backup, and at least one person in the office should know how to restore. Perform a trial restore just to be sure.

• Sorry, the Studio Organizer.com does not support and assumes no responsibility for your third party backup hardware,
software or procedure.

• Backing up is the user's responsibility.
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Using Dropbox or Carbon Copy

Dropbox (www.dropbox.com) and Carbon Copy are internet backup services. Dropbox is free if you have less than 2 gigabytes of data stored on
their server. Dropbox has proven to be a very reliable and easy to use and is highly recommended.

Each time you run the Backup Snapshot Wizard, just drag the dated backup folder created on your Desktop into your Dropbox folder. That's all
you have to do!

If you are using Dropbox or Carbon Copy to backup your files, there are two important warnings: First, do not place the Studio Organizer folder or
files inside the Dropbox or Carbon Copy folder, then use the files from that location.

The reason: while the Studio Organizer files are in use, they are constantly being updated on your hard drive. These backup services wants to
update a file as soon it changes. This means the Studio Organizer files, which are constantly changing, will constantly be uploaded to the backup
server. Not only will this cause constant traffic over your internet connection and really slow things down, but it could possibly cause file
corruption since the Studio Organizer files are constantly being written and read.

Second, do not back up the Studio Organizer by dragging the entire the Studio Organizer folder or any of the data files into the Dropbox or Carbon
Copy folder. Instead zip or compress any the Studio Organizer files or folders, then place them in the backup folder.

The reason: if the Studio Organizer files are not compressed, it's possible they could be opened inadvertently. This means you'll have two sets of
the Studio Organizer files and you could enter data into one set of files, then open the second set of files and enter more data. You now have
different data in two different set of files and there is no way to merge the data.

This potential problem is discussed in detail in the Only One Copy Of The Studio Organizer help note in the built in Help.
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Networking & Computer Maintenance

Networking the Studio Organizer
Networking is a great way to share the Studio Organizer with everyone in your office, but it requires additional hardware and
software. Networking is an optional feature which allows you to share the Studio Organizer in real time between two to nine
computers on a network. (If you wish to network more than nine computers, please contact technical support for details.)
You'll need a professional to set up the wiring and hubs.

The Studio Organizer.com does not charge any additional fees for a user to network, however, FileMaker Pro software must
be purchased and installed on each computer. You can purchase the FileMaker Pro 11 software from any source you wish,
such as www.softwaremedia.com. The cost is roughly $300 per computer. (Do not purchase the Advanced or Server
versions.)

Since it's not possible to record attendance while using other features of the Studio Organizer on a single computer,
networking is a great way to dedicate a computer to attendance check in, but it's not required. To spare you the expense of
networking, the Studio Organizer offers you the ability to dedicate a computer to attendance recording without networking.
Please read Attendance Computer: No Network Required in the built in Help or the Working With Data tutorial.

Purchasing and installing the FileMaker Pro software allows users to network as well as create PDF files, export to Excel,
and more.

Do You Have a Consultant?
Since you're using the Studio Organizer to manage a business, having a computer expert you can rely on is essential.
Computers are complex, and quite a bit of experience and knowledge is needed to properly maintain them. Be sure to retain
the services of a computer expert to provide troubleshooting and training, update drivers and to perform routine hard drive
and operating system maintenance.

Do Not Use Background Software
Please do not run or use background defragmenters, optimizers or hard drive diagnostic software while using the Studio
Organizer. It will interfere with the operation of the software and may cause file corruption.

Uninterruptible Power Supply (UPS)
For maximum protection, a UPS will protect your computer and your data from power interruptions.
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Additional Help & Information Resources

the Version History
Would you like to see what's new in the Studio Organizer? Or what's been changed, added or fixed in each new release?

Just click the Version Check button on the Main Menu, then click the Version History link.

Or go to www.StudioOrganizer.com and visit the Update page, then click the Version History link.

An internet connection is required.

Your Computer Guru
If you're not 100% comfortable working with computers, please read This is Your Brain in the Free eBooks folder inside the
Studio Organizer folder. If you're unfamiliar with the tasks technical support is asking you to perform, you will need
computer professional to visit your computer.

When trouble rears it's ugly head the fastest and most efficient solution is to let a professional tackle the problem.

There's just no substitute for having a computer expert right there in the room with you, teaching you new skills, solving
problems, and answering your questions. Computers are complex contraptions and finding your personal computer guru is as
important as having a good mechanic or doctor. Don't go it alone, you'll be much more productive if you have an expert
computer helper.

Don't want to hire a professional? Ask your students or parents. There's sure to a knowledgeable computer user who will be
happy to assist you. Read This is Your Brain for more about finding a computer guru.
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